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ПРЕДИСЛОВИЕ 

 
Лабораторный практикум является составной частью мето-

дического обеспечения дисциплины «Компьютерное делопроиз-

водство» и предназначен для студентов, обучающихся по направ-

лениям: 220301 - Автоматизация технологических процессов и 

производств. 

В его состав входят упражнения для изучения пакета про-

грамм Microsoft Office ХР. Каждая лабораторная работа посвящена 

определенной теме и построена по единому сценарию. 

В конце глав практикума приведены указания для выполне-

ния контрольных работ. 
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ГЛАВА 1. MICROSOFT WORD 

 
 Microsoft Word XP — один из лучших текстовых редакто-

ров. Он позволяет создавать и редактировать документы, добавлять 

в них таблицы и рисунки, изменять оформление абзацев и начерта-

ние шрифта, готовить документ к печати. Дополнительные модули 

Word позволяют выполнять такие операции, как проверка орфо-

графии и грамматики, формирование оглавлений и указателей, 

слияние с базой данных.  

 Современную жизнь нельзя представить без обилия тексто-

вых документов в бумажном и электронном виде. Word XP — это 

современная версия популярного текстового процессора, позволя-

ющая писать письма, форматировать тексты любой сложности, до-

бавлять в них рисунки, формулы и графики и даже верстать целые 

книги. Сегодня формат документов Word стал общепризнанным. 

Вы можете отправить такой документ по электронной почте в лю-

бую точку земного тара, и практически везде его смогут прочесть.  

1.1 Упражнение 1. Шаблоны  

 Шаблоны можно рассматривать как обычные документы 

Word, в которых кроме текста и списка стилен хранится информа-

ция о конфигурации панелей инструментов, макросы и параметры, 

определяющие вид документа и поведение программы. Шаблоны 

очень удобны, когда ряд документов требуется оформить в одина-

ковом стиле. Однажды настроив шаблон, вы создаете на его основе 

несколько файлов, которые наследуют имеющиеся в шаблоне текст 

и объекты, стили и оформление, макросы и параметры интерфейса 

Word. Вспомните, что на предыдущих занятиях мы уже пользова-

лись стандартными шаблонами Office, теперь давайте создадим 

свой собственный шаблон.  

1.  Откройте документ, созданный на первом занятии. Удали-

те из него весь текст, таблицу Excel и рисунок кактуса. На 

странице останется только надпись Геркулес и горизон-

тальная линия.  
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2.  Выберите команду Файл > Сохранить как (File > Save As). 

Откроется окно диалога Сохранение документа (Save As), 

показанное на рис. 1.1.  

3.  В раскрывающемся списке Тип файла (Save As Type) вы-

берите пункт Шаблон документа (Document Template).  

4.  В левой панели окна сохранения файла щелкните на кноп-

ке Мои документы (My Documents).  

5.  В панели инструментов щелкните на кнопке Создать папку 

(Create New Folder).  

6. В открывшемся окне диалога введите текст Шаблоны.  

7.  Щелкните на кнопке ОК.  

8. В поле Имя файла (File Name) введите Here.  

9. Щелкните на кнопке Сохранить (Save).  

 
Рис. 1.1. Сохранение шаблона  

 

10.  Выберите команду Файл > Закрыть (File > Close), чтобы 

закрыть окно шаблона. Теперь у вас есть шаблон с заголов-

ком Геркулес, сохраненный в специальной папке.  

11.  Чтобы указать программе Word, где следует искать шабло-

ны пользователя, выберите команду Сервис > Параметры 

(Tools > Options).  
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Рис. 1.2. Пути к служебным файлам  

 

12.  Щелкните в открывшемся окне диалога на вкладке Распо-

ложение (File Locations). На этой вкладке, показанной на 

рис. 1.2, хранится информация об именах, некоторых спе-

циальных папок, в том числе и имя папки шаблонов поль-

зователя.  

13.  Щелкните на строчке Шаблоны пользователя (User 

Templates).  

14.  Затем щелкните на кнопке Изменить (Modify). Откроется 

окно диалога, которое очень похоже на окно сохранения 

файлов, но предназначено для выбора папки.  

15. Щелкните в левой панели этого окна на кнопке Мои докумен-

ты (My Documents), затем в основной области окна диалога 

дважды щелкните на недавно созданной папке Шаблоны.  

16.  Щелкните на кнопке ОК. Вы вернетесь на вкладку Распо-

ложение (File Locations), но теперь в строке Шаблоны поль-

зователя (User Templates) указана правильная папка.  

17.  Снова щелкните на кнопке ОК, чтобы закрыть окно пара-

метров.  
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18.  Теперь попробуйте создать на базе построенного шаблона 

новый документ. Выберите команду Файл > Создать (File > 

New). В правой стороне экрана появляется окно Создание до-

кумента (New Document) области задач. В разделе Создание с 

помощью шаблона (New from Template) перечислены недавно 

используемые шаблоны и ряд стандартных шаблонов. Щелк-

ните на значке Общие шаблоны (General Templates). Значок 

шаблона Here появился в окне диалога Шаблоны (Templates), 

как показано на рис. 1.3. Сюда кроме стандартных шаблонов 

выводятся значки всех файлов с расширением .dot, записан-

ных в папку с шаблонами пользователя.  

 

 
Рис. 1.3. Выбор шаблона документа  

 

19.  С помощью переключателя Создать (Create New) выберите 

тип создаваемого 4:>айла. Положение Документ 

(Document) соответствует созданию обычного текстового 

документа, а Шаблон (Template) позволяет создать новый 

шаблон.  

20. Дважды щелкните на значке Here. Откроется новый документ, 

в котором сразу появится большая надпись Геркулес, как по-

казано на рис. 1.4. Теперь, пользуясь новым шаблоном, вы 

можете быстро добавлять такие надписи в начало каждого до-

кумента гипотетической компании Геркулес, и все они будут 

точными копиями заголовка, хранящегося в шаблоне.  
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Рис. 1.4. Документ, построенный на базе шаблона пользователя  

 

 Следует заметить, что так называемый «Обычный доку-

мент», который создается щелчком на кнопке Создать (New) пане-

ли инструментов или выбором значка Новый документ (Blanck 

Document) в разделе Создание документа (New) окна области за-

дач, на самом деле тоже построен на основе шаблона. Этот шаблон 

записан в файле Normal.dot, который хранится в папке C:\Microsoft 

Office\Templates [ Предполагается, что пакет Office 2002 был уста-

новлен в папку Microsoft Office диска С:.]. Шаблон NormaLdot иг-

рает важную роль. Он определяет исходную конфигурацию Word, 

т. е. вид и поведение программы при ее запуске.  

Примечание  
Если вы обнаружили, что Word выглядит как-то странно или рабо-

тает неверно, попробуйте закрыть программу и удалить файл 

Normal.dot. При следующем запуске Word этот шаблон будет сге-

нерирован заново в соответствии со стандартной конфигурацией, 

заложенной в Word разработчиками программы.  
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1.2 Упражнение 2. Мастер создания документа  

 Создавая документ с помощью мастера, вы имеете дело как 

бы с интеллектуальным шаблоном, который может менять свою 

конфигурацию в соответствии с конкретными запросами пользова-

теля. Мастера часто вставляют в документ специальные макросы 

— небольшие программы, автоматизирующие ввод текста. На 

предыдущих занятиях вы уже не раз пользовались мастерами. Да-

вайте детально познакомимся с возможностями этих помощников 

на примере одного из них — мастера профессионально оформлен-

ного резюме.  

1.  Выберите команду Файл > Создать (File > New). В окне 

диалога Создание документа (New Document) области задач 

в разделе Создание с помощью шаблона (New From 

Template) щелкните на значке Общие шаблоны (General 

Templates). В появившемся окне диалога Шаблоны 

(Templates) раскройте вкладку Другие документы (Other 

Documents) и дважды щелкните на значке Мастер резюме 

(Resume Wizard). Откроется первое окно мастера, описы-

вающее назначение запущенного модуля.  

Примечание  
Обратите внимание, что значки мастеров отличаются от значков 

обычных шаблонов наличием изображения волшебной палочки.  

2.  Щелкните на кнопке Далее (Next).  

3.  Во втором окне мастера, показанном на рис. 1.5, установив 

переключатель в правое положение, выберите для своего 

резюме изысканный стиль. Затем щелкните на кнопке Да-

лее (Next).  

4.  В следующем окне выберите положение переключателя 

Профессиональное (Professional CV) и снова щелкните на 

кнопке Далее (Next).  

Примечание  
В нижней части окна любого мастера Office XP есть пять кнопок. 

Две из них — Далее (Next) и Назад (Back) позволяют перемещаться 

по окнам мастера. Если вы ошиблись или решили поменять дан-

ные, введенные ранее, щелкая на кнопке Назад (Back), вернитесь к 

одному из предыдущих окон и скорректируйте параметры мастера. 

При этом нет нужды заново повторять всю процедуру. Кнопка От-
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мена (Cancel) позволяет в любой момент прервать работу мастера. 

Кнопка Готово (Finish) инициирует генерацию результата на базе 

уже введенных данных. Наконец, кнопка с вопросительным знаком 

позволяет получить справку.  

 
 

 
Рис. 1.5. Второе окно мастера резюме  

5. В двух следующих окнах введите свое имя, адрес, телефо-

ны и укажите, какую информацию о вас следует включать в 

резюме.  
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6.  В шестом окне мастера, показанном на рис. 1.6, установите 

флажки, соответствующие тем разделам, которые должны 

быть включены в резюме.  

 

 
Рис. 1.6. Шестое окно мастера резюме  

 

7.  Щелкните на кнопке Далее (Next).  

8. В следующем окне укажите, какие дополнительные разде-

лы следует включать в документ, а с помощью последнего 

из информативных окон добавьте при необходимости раз-

делы, не предусмотренные разработчиками мастера. Щелк-

ните на кнопке Далее (Next).  

9.  В последнем окне мастера, информирующем о том, что все 

готово для создания документа, щелкните на кнопке Готово 

(Finish). Мастер сгенерирует документ, показанный на рис. 

1.7. В нем появятся введенные вами данные и дополнитель-

ные поля, которые можно заполнить позже.  

10. Сохраните это резюме в папке Мои документы (My 

Documents) под именем Резюме. Теперь вы умеете строить 

документы на базе шаблонов и наполнять их информацией 

с помощью мастеров. Однако иногда случается так, что 

текстовое содержание уже имеется в обычном текстовом 

файле ASCII, например, полученном по электронной почте. 

Такой текст легко импортируется в Word, где его можно 
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оформить с помощью мощных возможностей этого тексто-

вого редактора. Чтобы открыть ASCII-текст формата DOS, 

выполните следующие шаги.  

11.  Выберите команду Файл > Открыть (File > Open).  

12.  В раскрывающемся списке Тип файлов (Files Of Types) ок-

на диалога Открытие документа (Open) выберите пункт 

Текстовые файлы (Text Files) или Все файлы (All Files). 

 

 
Рис. 1.7. Документ, сгенерированный мастером  

 

13.  Найдите текстовый файл и дважды щелкните на его значке. 

Откроется окно диалога Преобразование файла (Convert 

File), показанное на рис. 1.8.  
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Рис. 1.8. Выбор варианта преобразования   

 

14.  Выберите пункт Текст MS-DOS (MS-DOS Text).  

 

Примечание  
Если окно преобразования не появится, вы не сможете правильно 

настроить отображение русских букв. В этом случае выберите ко-

манду Сервис > Параметры (Tools > Options) и на вкладке Общие 

(General) установите флажок Подтверждать преобразование при 

открытии (Confirm Conversion At Open). Затем повторите импорт 

текстового файла.  

15.  Щелкните на кнопке ОК. Текст DOS будет преобразован в 

формат Windows. При импорте файлов другого формата 

выбирайте в окне диалога Преобразование файла (Convert 

File) нужный вариант преобразования.  

 

Режимы просмотра  
 В Microsoft Word один и тот же документ можно отобра-

жать в четырех перечисленных ниже режимах просмотра.  
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 Обычный (Normal View) — предназначен для ввода и фор-

матирования текста, отображаемого в виде непрерывной 

вертикальной полосы.  

 Разметка страницы (Print Layout View) — позволяет оце-

нить расположение текста и объектов относительно физи-

ческих страниц документа.  

 Структура (Outline View) — служит для задания и редакти-

рования иерархической структуры разделов основного тек-

ста, что позволяет полностью отвлечься от графических 

объектов и реальных размеров страниц и сконцентрировать 

внимание на содержании.  

  Веб-документ (Web Layout View) — предназначен для 

формирования web-страниц, для которых характерна не-

ограниченная длина.  

 Режимы просмотра проще всего переключать с помощью 

кнопок, расположенных в левом нижнем углу окна документа (рис. 

1.9). Не забывайте про наличие разных режимов, всегда работайте 

в том из них, который лучше соответствует решаемой задаче.  

 

 
Рис. 1.9. Кнопки режимов просмотра  
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1.3 Упражнение 3. Обычный режим  

 Создавая или модифицируя текстовый документ, вы чаще 

всего работаете в обычном режиме просмотра. На рис. 1.10 показан 

пример документа в этом режиме и основные элементы окна Word. 

При обычном просмотре документ имеет неограниченную длину, 

хотя его ширина определяется размером страницы. Разбиение на 

страницы показано горизонтальными пунктирными линиями. В 

этом режиме на экране не видны фигуры, рисунки и другие графи-

ческие объекты.  

 

 
Рис. 1.10. Документ Word в обычном режиме  

 

 Строка состояния Word в любом режиме просмотра выво-

дит одну и ту же информацию, которая помогает ориентироваться 

в больших документах. В первом слева поле строки состояния вид-

ны номер текущей страницы, номер текущего раздела, а далее че-

рез дробь — номер текущей страницы и число страниц в докумен-

те. Во второе поле выводится расстояние от левого края документа 

до текущего положения текстового курсора, затем номера текущих 

строки и столбца.  

1.  Откройте любой не очень короткий документ и с помощью 

команды Вид > Обычный (View > Normal) включите обыч-

ный режим просмотра (если текущим является другой ре-

жим).  

2.  Щелкните на кнопке Схема документа (Document Map). В 

левой части окна появится панель, демонстрирующая 

иерархическую структуру разделов документа, как показа-

но на рис. 1.11. Указанная кнопка играет роль флажка. По-

вторный щелчок на ней скроет панель схемы. Такую панель 

можно открыть и в любом другом режиме просмотра.  

3.  Щелкните в панели схемы документа на одном из пунктов. 

Текст в основном окне переместится к соответствующему 

разделу.  
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Примечание  
Раздел характеризуется наличием заголовка, отмеченного специ-

альным стилем. Вы познакомитесь с этими стилями в упражнении 

5 этого занятия.  

 

 
Рис. 1.11. Схема документа  

 

4. Чтобы прокрутить текст вручную, пользуйтесь кнопками и 

ползунком вертикальной полосы прокрутки, расположен-

ной в правой части окна. Полоса прокрутки есть и в панели 

схемы документа.  

5. Щелкните на кнопке Следующая страница (Next Page). 

Текст в окне переместится к началу следующей страницы. 

Кнопка Предыдущая страница (Previous Page) выполняет 

обратную процедуру, прокручивая текст на одну страницу 

вверх.  
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6. Щелкните на кнопке Выбор объекта перехода (Select 

Browse Object). Откроется показанное на рис. 1.12 окно со 

значками. Эти значки позволяют изменять функции кнопок 

Следующая страница (Next Page) и Предыдущая страница 

(Previous Page).  

 
Рис. 1.12. Выбор объекта перехода 

 

7.  Попробуйте щелкнуть на значке Разделы (Browse By 

Section). Теперь указанные кнопки будут прокручивать до-

кумент соответственно к предыдущему и следующему раз-

делу (а не к странице).  

8. В обычном режиме в верхней части окна может распола-

гаться горизонтальная линейка, позволяющая контролиро-

вать горизонтальные отступы. Чтобы показать или скрыть 

линейку, выберите команду Вид > Линейка (View > Ruler).  

9.  Вероятно, вы захотите настроить масштаб отображения 

текста по своему вкусу. Для этого щелкните на раскрыва-

ющемся списке Масштаб (Zoom) панели инструментов 

Стандартная (Standard) и выберите подходящий масштаб. 

Чтобы ширина текста в точности равнялась ширине окна, 

выберите последний пункт По ширине страницы (Page 

Width).  

10.  Выполните команду Вид > Во весь экран (View > Full 

Screen). Окно Word развернется на весь экран компьютера. 

При этом исчезнут меню, заголовок окна, панели инстру-

ментов, строка состояния и полоса прокрутки. Будет виден 

только сам документ и кнопка Вернуть обычный режим 

(Close Full Screen). Такой полноэкранный режим просмотра 

позволяет целиком сосредоточиться на содержании доку-

мента.  

11.  Чтобы вернуть исчезнувшие элементы интерфейса, щелк-

ните на кнопке Вернуть обычный режим (Close Full Screen).  
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Примечание  
В полноэкранном режиме можно пользоваться всеми командами 

меню. Переместите указатель мыши вплотную к верхнему краю 

экрана, и перед вами появится всплывающая строка меню Word.  

12. Дважды щелкните в любом из двух левых полей строки со-

стояния. Откроется окно перехода к объекту, показанное на 

рис. 1.13.  

13.  В списке Объект перехода (Go To What) выберите тип объ-

екта, который нужно найти, например пункт Страница 

(Page).  

 
Рис. 1.13. Вкладка перехода окна диалога поиска и замены 

 

14. В поле Введите номер страницы (Enter Page Number), 

название которого варьируется в зависимости от выбранно-

го типа объекта, введите номер страницы, к которой нужно 

перейти. Для перехода вперед или назад на N страниц отно-

сительно текущей введите соответственно +N или -N, где N 

— целое число.  

15.  Щелкните на кнопке Перейти (Go To). Документ прокру-

тится до искомого объекта.  

1.4 Упражнение 4. Разметка страницы  

 Режим разметки страниц позволяет видеть документ таким, 

каким он будет на бумажных страницах, распечатанных на принте-

ре. Здесь в виде белых прямоугольников отображаются страницы 

документа, на которых наряду с текстом видны абсолютно все объ-

екты, как показано на рис. 1.14. Если документ содержит много-

численные рисунки или графики, с ним удобнее работать именно в 

режиме разметки страницы.  



 19 

 
Рис. 1.14. Режим разметки страницы  

 

Окно режима разметки практически не отличается от окна 

обычного режима. Но включив отображение линейки, вы кроме 

горизонтальной линейки увидите еще и вертикальную, которая 

позволяет оценивать положение объектов на странице по второй 

координате. Приемы перемещения по документу тоже совпадают в 

обоих режимах, однако в раскрывающемся списке Масштаб (Zoom) 

в режиме разметки появляются три дополнительных пункта —По 

ширине текста (Text Width), Страница целиком (Whole Page) и Две 

страницы (Two Pages), названия которых не требуют дополнитель-

ных пояснений.  

Работая в режиме разметки, не спешите расставлять объекты 

и форматировать текст. Для начала следует настроить размеры 

страницы и ее полей.  

1.  Выберите команду Файл > Параметры страницы (File > 

Page Setup).  
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2.  В открывшемся окне диалога щелкните на вкладке Размер 

бумаги (Paper Size), которая показана на рис. 1.15.  

3.  В списке Размер бумаги (Paper Size) выберите тот размер 

листа, на котором должен печататься документ.  

4. Чтобы задать нестандартный размер, выберите пункт Дру-

гой (Custom Size) и введите ширину и высоту страницы в 

счетчики Ширина (Width) и Высота (Height).  

 
Рис. 1.15. Параметры страницы  

 

5.  После настройки размеров страницы следует указать раз-

меры отступов и выбрать вариант вывода текста на прин-

тер. Для этого раскройте вкладку Поля (Margins), которая 

показана на рис. 1.16.  
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6.  В счетчики Верхнее (Тор), Нижнее (Bottom), Левое (Left) и 

Правое (Right) введите ширину полей страницы.  

7. С помощью переключателя Ориентация (Orientation) окна 

диалога параметров страницы выберите книжное или аль-

бомное расположение страницы относительно текста.  

 
Рис. 1.16. Настройка полей  

 

8.  Если вы собираетесь печатать документ на обеих сторонах 

листов, а левый и правый отступы не равны между собой, 

то в раскрывающемся списке Несколько страниц: (Multiple 

Pages) выберите Зеркальные поля (Mirror Margins). Это 

обеспечит правильную расстановку полей. При выборе 2 

страницы на листе (2 Pages Per Sheet) на одном листе бума-
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ги будут размещены две страницы. Поле Образец (Preview) 

отображает текущую раскладку страниц и позволяет визу-

ально проконтролировать введенные параметры.  

Примечание  
В верхнем и нижнем поле страницы расположены верхний и ниж-

ний колонтитулы, в которых размещаются, например, номера стра-

ниц или названия текущих разделов документа. Если вы пользуе-

тесь колонтитулами, не делайте верхнее и нижнее поля слишком 

узкими.  

9.  Раскройте вкладку Источник бумаги. В разделе Различать 

колонтитулы: с помощью соответствующих счетчиков 

настройте расстояния от края страницы до верхнего и ниж-

него колонтитулов.  

10.  Щелчком на кнопке О К закройте окно диалога параметров 

страницы.  

11.  Поля можно настроить и с помощью линеек. Чтобы увели-

чить ширину левого поля, поместите указатель мыши на 

границу серой и белой областей горизонтальной линейки 

(см. рис. 1.14), нажмите кнопку мыши и перетаскивайте 

границу поля. Аналогично настраиваются и остальные три 

поля страницы.  

12. В многостраничном документе, как правило, требуется рас-

становка номеров страниц. Нет смысла делать это вручную. 

Word умеет нумеровать страницы автоматически. Выберите 

команду Вставка > Номера страниц (Insert > Page Numbers). 

Откроется окно диалога, показанное на рис. 1.17.  

 

 
Рис. 1.17. Добавление нумерации страниц  
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13.  С помощью раскрывающегося списка Положение (Position) 

укажите, должны ли номера страниц располагаться вверху 

или внизу страницы. В списке Выравнивание (Alignment) 

выберите нужный режим выравнивания номера в колонти-

туле.  

14.  Чтобы номер отсутствовал на первой странице документа, 

сбросьте флажок Номер на первой странице (Show Number 

On First Page).  

15. Если требуется дополнительное форматирование номеров, 

щелкните на кнопке Формат (Format) и настройте парамет-

ры окна диалога Формат номера (Page Number Format).  

16.  Щелчками на кнопках OK закройте все окна диалога. Word 

автоматически пронумерует страницы документа. При ре-

дактировании текста вы сможете выбрасывать и вставлять 

фрагменты, а также перемещать целые блоки страниц. 

Word автоматически скорректирует нумерацию и обеспечит 

правильную последовательность чисел.  

17. Чтобы изменить шрифт номеров страниц и добавить в ко-

лонтитулы другую информацию, выберите команду Вид > 

Колонтитулы (View > Header And Footer). Текст документа 

станет блеклым, а колонтитулы будут выделены пунктир-

ными прямоугольниками, как показано на рис. 1.18. Кроме 

того, появится панель инструментов Колонтитулы (Header 

And Footer).  

18.  С помощью полосы прокрутки найдите любой прямо-

угольник с надписью Верхний колонтитул (Header).  

19.  Введите в нем текст Это верхний колонтитул. Теперь в 

верхнем поле каждой страницы будет выведена такая 

надпись. Вы скажете, что-подобные заголовки страниц ни-

кому не нужны. Да, конечно, это лишь простейший пример. 

Давайте посмотрим, какие возможности предлагает панель 

инструментов Колонтитулы (Header And Footer).  

20.  Щелкните в прямоугольнике Нижний колонтитул (Footer).  

21.  В панели Колонтитулы (Header And Footer) щелкните на 

кнопке Вставить авто текст (Insert AutoText).  

22. Выберите в раскрывающемся меню пункт Полное имя фай-

ла (Filename And Path). Теперь вы не забудете, как называ-

ется файл, в котором хранится источник распечатанного 
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текста. Имя этого файла появится в нижнем колонтитуле 

каждой страницы. Если вы переименуете файл документа 

или переместите его в другую папку, то при следующем от-

крытии документа в нижнем колонтитуле появится уже но-

вое имя файла. Панель инструментов Колонтитулы (Header 

And Footer) позволяет-таюке вставлять в колонтитулы дату 

и время последнего обновления документа, дату печати до-

кумента, имя автора и другую информацию.  

 

 
Рис. 1.18. Редактирование колонтитулов  

 

20.  Чтобы закрыть режим просмотра колонтитулов, щелкните 

на кнопке Закрыть (Close) панели инструментов Колонти-

тулы (Header And Footer). Иногда, просмотрев документ в 

режиме разметки страницы, вы можете остаться недоволь-

ны тем, как Word разбил текст на страницы. В этом случае 

вручную вставьте в текст дополнительные разрывы стра-

ниц.  
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21. Поместите курсор в ту точку, где должна начинаться новая 

страница, и выберите команду Вставка > Разрыв (Insert > 

Break). Откроется окно диалога, показанное на рис. 1.19. В 

нем верхний переключатель позволяет из трех положений 

выбрать тип разрыва. Нижний переключатель позволяет 

вставить метку начала следующего раздела и выбрать, как 

должен располагаться раздел: с начала следующей страни-

цы, с четной, с нечетной или без разрыва страницы.  

 

 
Рис. 1.19. Вставка разрыва  

 

25.  Выберите положение переключателя Новую страницу 

(Page Break).  

26.  Затем щелкните на кнопке ОК. Текст правее и ниже курсо-

ра будет перенесен в начало следующей страницы, а конец 

текущей страницы останется пустым.  
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Режим электронного документа, который включается коман-

дой Вид > Веб-документ (View > Web Layout), является как бы 

комбинацией обычного режима и режима разметки страницы. 

Электронный документ позволяет видеть все объекты, включая ри-

сунки и графики, перемещать их по документу и изменять их раз-

мер. Но в режиме электронного документа нет разбивки на страни-

цы и весь текст отображается в виде бесконечной вертикальной 

ленты. Здесь нет и вертикальной линейки. Поскольку предполага-

ется, что электронный документ будет публиковаться на web-узле, 

разработчики Word учли, что web-страницы могут иметь любую 

длину, а для их просмотра в окне браузера используется верти-

кальная полоса прокрутки.  

Если вы пользуетесь текстовым процессором Word для под-

готовки web-страниц, вместо режима разметки страниц всегда 

пользуйтесь режимом электронного документа. В этом случае по-

сле преобразования в формат HTML не произойдет потери назна-

ченного форматирования. Например, на web-странице невозможно 

разместить текст в несколько столбцов (если не пользоваться таб-

лицами), поэтому режим просмотра электронного документа игно-

рирует такое форматирование, четко следуя стандартам HTML.  

Примечание  
Запись формата HTML в Office XP выполняется без ошибок, а по-

лученная web-страница точно повторяет вид исходного электрон-

ного документа.  

Чтобы сформировать web-страницу, достаточно выбрать команду 

Файл >Сохранить как веб-страницу (File > Save As Web Page) и в 

окне диалога Сохранение документа (Save As) ввести имя HTML-

файла. Полученную web-страницу можно продолжать модифици-

ровать как в Word, так и в любом web-редакторе.  

Примечание  
Обратите внимание, что после преобразования в web-страницу или 

после открытия файла формата HTML в меню Вид (View) появля-

ется новая команда Источник HTML (HTML Source), выбор кото-

рой открывает окно с исходным HTML-кодом, формирующим ре-

дактируемый документ.  
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1.5 Упражнение 5. Структура документа  

Любой достаточно объемный документ обычно состоит из 

разделов и подразделов разного уровня. Самые внешние разделы, 

например части той книги, которую вы сейчас читаете, выделяются 

крупными заголовками. Для занятий выбраны заголовки поменьше. 

Названия упражнений набраны еще более мелким шрифтом. Такое 

разбиение документа на отдельные блоки не чуждо и для Word. 

Этот текстовый процессор позволяет присваивать названиям тех 

или иных разделов специальные заголовочные стили, которые, во-

первых, обеспечивают одинаковое оформление всех заголовков 

определенного уровня, а во-вторых, дают знать программе Word, 

где начинается и заканчивается очередной раздел. Эта информация 

позволяет Word правильно форматировать документ. Например, 

заголовок раздела никогда не окажется па другой странице, от-

дельно от текста этого раздела.  

Если вы редактируете большой документ, имеющий иерар-

хическую совокупность вложенных друг в друга разделов, с ним 

удобно работать в режиме структуры. В этом режиме просмотра, 

показанном на рис. 1.20, удобно переставлять, удалять и добавлять 

разделы, изменять их уровень.  

1.  Щелчком на кнопке Создать (New) откройте новый доку-

мент.  

2.  С помощью команды Вид > Структура (View > Outline) пе-

реключитесь в режим структуры.  

3.  Введите текст Параметры оборудования. Нажмите клави-

шу Enter. Затем введите строку Специальные вопросы, сно-

ва нажмите Enter и введите Разрешение проблем. Это будут 

названия трех разделов верхнего уровня. Им соответствует 

стиль Заголовок! (Headingi).  

4.  Переместите курсор в конец первой строки и нажмите кла-

вишу Enter. Появится еще один заголовок раздела. Чтобы 

понизить его уровень, нажмите клавишу Tab. Новая строка 

станет подразделом темы Параметры оборудования (см.рис. 

1.20). Введите текст Быстродействие.  

5.  Нажмите клавишу Enter и введите заголовок еще одного 

раздела второго уровня. Обратите внимание, что теперь не 
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нужно нажимать клавишу Tab. В режиме структуры стиль 

нового абзаца всегда повторяет заголовочный стиль преды-

дущего абзаца.  

6. Введите еще несколько заголовков разделов второго и тре-

тьего уровней, чтобы получить текст, показанный на рис. 

1.20. Для понижения уровня от второго к третьему нажи-

майте клавишу Tab. Имейте в виду, что заголовкам без от-

ступа соответствует стиль Заголовок! (Heading!), заголов-

кам с одинарным отступом — стиль Заголовок2 (Heading2), 

а заголовкам с двойным отступом — стиль Заголовок З 

(Heading3). Следите за полем Стиль (Style) панели инстру-

ментов Форматирование (Formatting).  

 

 
Рис. 1.20. Документ в режиме структуры  

 

 В нем всегда указано название стиля того абзаца, в котором 

находится текстовый курсор. Если вы ошиблись и заголовок полу-
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чил неверный стиль, не огорчайтесь. Чтобы понизить уровень заго-

ловка, щелкните на нем мышью и нажмите Tab. Для повышения 

уровня заголовка следует нажать клавиши Shift+Tab. Слева от каж-

дого заголовка имеется знак «плюс» или «минус». «Плюс» говорит 

о том, что данный раздел не пуст и наполнен определенным содер-

жанием (в данном случае заголовками вложенных подразделов). 

Пустым разделам соответствует знак «минус».  

Примечание  
Чтобы узнать стиль абзаца, щелкните в нем и взгляните на список 

Стиль (Style) панели инструментов Форматирование (Formatting). 

Абзацные стили используются в Word не только для выделения 

заголовков. Любому абзацу можно назначить стандартный или 

специально разработанный для него стиль. Способы форматирова-

ния документа с помощью стилей будут рассмотрены на следую-

щем занятии.  

 

 
Рис. 1.21. Тот же документ в обычном режиме просмотра  
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7. Щелчком на кнопке Обычный режим (Normal) переключи-

тесь в обычный режим просмотра. Вы увидите введенные 

заголовки разделов расположенными друг под другом без 

отступов. Они будут отличаться шрифтом. Каждому заго-

ловочному стилю соответствует свой шрифт, как показано 

на рис. 1.21.  

8. Теперь наполните созданные разделы каким-либо содержа-

нием. Для этого щелкайте в конце названия каждого разде-

ла, нажимайте клавишу Enter и вводите текст. Пусть каж-

дый раздел состоит всего из нескольких слов. Сейчас важна 

не общая длина документа, а его иерархическая структура. 

Обратите внимание, что в обычном режиме при нажатии 

клавиши Enter формируется абзац не заголовочного стиля, а 

стиля Обычный (Normal), который соответствует простому 

тексту.  

9.  Переключитесь обратно в режим Структура (Outline). Вы 

увидите весь текст документа.  

10.  В панели инструментов Структура (Оutlining), которая по-

является при переключении в режим структуры, выберите в 

раскрывающемся списке пункт Показать уровень 2 (Show 

Level 2). Содержимое документа свернется, и на экране 

останутся только заголовки первого и второго уровней. 

Кнопки панели Структура (Outlining), показанной на рис. 

1.22, позволяют развернуть документ до разделов любого 

уровня вложения. Выбор в раскрывающемся списке пункта 

Показать все уровни (Show All Levels) выводит на экран 

весь документ. Кнопки со знаками «плюс» и «минус» той 

же панели разворачивают и сворачивают тот раздел, в ко-

тором находится текстовый курсор.  

11.  Щелкните в строке заголовка Установка.  

12.  Затем щелкните на кнопке Вниз (Move Down) панели ин-

струментов Структура (Outlining). Заголовок Установка 

сместится вниз под заголовок Обновление.  

 
Рис. 1.22. Панель инструментов режима структуры  
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13.  Теперь в раскрывающемся списке выберите пункт Пока-

зать все уровни (Show All Levels), чтобы снова вывести на 

экран все содержимое документа. Выполненное перемеще-

ние строки заголовка повлекло сдвиг всего раздела.  

14. Щелкните назнаке «плюс» слева от заголовка раздела 

Быстродействие. Окажутся выделенными этот раздел и все 

его подразделы, как показано на рис. 1.23.  

 

 
Рис. 1.23. Выделение раздела документа  

 

15. Нажатием клавиш Ctrl+Х вырежьте выделенный фрагмент. 

Переместите текстовый курсор в начало заголовка Обнов-

ление и щелкните на кнопке Вставить (Paste) панели ин-

струментов Стандартная (Standard). Выделенный ранее 

подраздел будет целиком перенесен внутрь раздела Специ-

альные вопросы.  
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1.6 Контрольное упражнение  

Пришло время проверить, насколько хорошо вы усвоили материал 

этого занятия.  

1.  Создайте новый шаблон на основе шаблона Here.dot.  

o Как в окне диалога создания документа вывести 

список шаблонов в виде таблицы с дополнительной 

информацией о файлах?  

2. Переключитесь в режим структуры и введите несколько за-

головков первого уровня, которые соответствуют стандарт-

ным разделам шаблона, предназначенного, например, для 

оформления ежемесячных отчетов отделов компании.  

o Подумайте, как с помощью панели инструментов 

Структура (Outlining) убрать оформление заголов-

ков разделов и вместить в окно больше текста?  

3.  Переключитесь в обычный режим и введите в разделы 

шаблона пояснительный текст, указывающий на то, какая 

информация должна размещаться в каждом разделе.  

4. В режиме разметки страниц добавьте нумерацию страниц. 

Установите ширину левого поля страницы 4 см, а правого 

— 3 см.  

o   Для переплета отчетов необходимо добавить в 

верхней части страницы дополнительное поле в 2 

см. Как это сделать?  

5. Распечатайте новый шаблон и сохраните его в папке Мои 

документы (My Documents).  
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ГЛАВА 2. MICROSOFT EXCEL 

 
 Вам, наверное, не раз приходилось подсчитывать сумму 

или среднее значение столбцов или строк таблиц. Excel может вы-

полнять с данными ячеек листа те же вычисления, которые выпол-

няются с помощью калькулятора. Формулы и функции Ехсе1 спо-

собны обрабатывать величины как конкретных ячеек таблицы, так 

и целых блоков (например, строк или столбцов). Формулы Excel 

могут быть очень сложны, а результат их вычислений, в свою оче-

редь, можно использовать в других расчетах. Неоспоримым пре-

имуществом электронной таблицы является то, что при изменении 

данных листа результаты вычислений моментально обновляются.  

 Все вычисления в Excel выполняются с помощью формул, 

которые можно вводить в любые ячейки листа. Если содержимое 

ячейки начинается со знака равенства (=), Excel полагает, что вслед 

за этим знаком идет формула, и пытается выполнить указанную 

операцию. Когда это удается, в ячейку с такой формулой выводит-

ся результат расчета. Если что-то не так, появляется сообщение об 

ошибке. Сама формула отображается в ячейке только в том случае, 

когда ячейка находится в режиме редактирования текста (то есть 

после двойного щелчка на ней). Если ячейка просто выделена, то ее 

формула выводится в строке формулы в верхней части окна Excel.  

2.1 Упражнение 1. Ввод формул  

 Самым простым способом задания формулы является ее 

непосредственный ввод в строку формул. У этого варианта есть 

лишь один недостаток — вы должны помнить правила построения 

формул Excel, названия встроенных функций и методы ссылок на 

ячейки листа.  

1.  Откройте фaйл Электронная таблица.xls, созданный на 

предыдущем занятии. В этой рабочей книге есть лист Фор-

мулы, измененный в контрольном упражнении предыдуще-

го занятия. Раскройте его. Первые семь строк листа должны 

выглядеть так, как показано па рис. 2.1, остальные ячейки 

будут пусты. Если это не соответствует действительности, 

отредактируйте лист.  
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2. Щелкните на ячейке В10 и введите формулу =(СЗ-

ВЗ)/ВЗ*100.  

 Знак равенства указывает программе Excel, что ячейка со-

держит формулу. СЗ и ВЗ — это ссылки на содержимое соответ-

ствующих ячеек. Если предположить, что таблица содержит объем 

продаж продукции различным клиентам, то (СЗ-ВЗ) — это прирост 

продаж для фирмы Фантом с января по февраль. Разделив полу-

ченную величину на ВЗ (продажи за январь), получаем относи-

тельный прирост продаж за месяц. Результат умножается на 100, 

что дает прирост в процентах. Как видите, в ячейки можно вводить 

простые, арифметические выражения со знаками +, -, *, / и скобка-

ми, определяющими последовательность выполнения операций.  

 
Рис. 2.1. Ввод формулы  
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3. Щелкните на ячейке В10 и перетащите угловой маркер вы-

деления вправо, чтобы оказались охваченными ячейки с 

В10 по F10.  

Примечание  
Чтобы результат выводился в процентах, не обязательно умножать 

его на 100, достаточно сменить формат данных, выделив ячейку и 

щелкнув на кнопке Процентный формат панели инструментов 

Форматирование.  

 На первый взгляд кажется, что в ячейки C10:F10 должна 

дублироваться формула ячейки В 10, но это не так. Excel поддер-

живает механизм относительных ссылок на ячейки. Когда формула 

переносится на одну клетку вправо, точно так же смещаются все 

ссылки этой формулы (это верно и для смещения формулы в лю-

бых других направлениях на любое число клеток). То есть в ячейке 

С11 появится формула =(D3-C3)/C3*100, в ячейке D10 - формула 

=(E3-D3)/D3*100 и т. д. Чтобы проверить это, щелкните на каждой 

ячейке и изучите содержимое строки фор-•мул. В итоге ячейки 

строки 10 будут содержать относительный прирост продаж компа-

нии Фантом по месяцам.  

4.  Выделите строки с третьей по седьмую.  

5.  Щелчком на кнопке Вырезать (Cut) панели инструментов 

Стандартная (Standard) вырежьте их содержимое.  

6.  Щелкните на ячейке А2 правой кнопкой мыши и выберите 

в контекстном меню команду Вставить. Данные таблицы 

переместятся вверх на одну строку. Теперь снова изучите 

формулы ячеек строки 10.  

 При смещении ячеек с данными с помощью операций выре-

зания и вставки ссылки на эти ячейки в имеющихся формулах мо-

дифицируются так, что в обновленной таблице в расчетах прини-

мают участие те ячейки, в которые были перемещены исходные 

данные.  

Примечание  
Если необходимо, чтобы знак равенства в начале текста ячейки не 

воспринимался как индикатор формулы, а интерпретировался как 

символ, поставьте перед ним одинарную кавычку (').  
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2.2 Упражнение 2. функции  

 Excel поддерживает множество стандартных математиче-

ских функций, которые можно вставлять в формулы. С тремя из 

них — СУММ (SUM), СРЗНАЧ (AVERAGE) и СЧЕТ (COUNT) — 

вы познакомились на предыдущем занятии. Чтобы научиться рабо-

тать с другими функциями, выполните следующие шаги.  

1.  Щелкните на ячейке Н8 и введите текст Максимум. 

Нажмите клавишу Tab.  

 

 
Рис. 2.2. Вставка функции  

 

2. Щелкните на кнопке Вставка функции (Paste Function) па-

нели инструментов Стандартная. Откроется окно диалога, 

показанное на рис. 2.2. Чтобы найти нужную функцию, 

можно кратко описать желаемую процедуру в текстовом 

поле Поиск функции (Search for a function) или же выбрать 

ее категорию в списке категорию: (Select a Category) этого 

окна диалога, а затем пролистать список Выберите функ-

цию (Select a Function Name). Выделив имя одной из функ-
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ций, вы увидите ее описание в нижней части окна диалога. 

Excel делит все функции на следующие категории:  

o Финансовые (Financial) — функции для расчета 

амортизации имущества, стоимости основных фон-

дов, нормы прибыли, величины выплат на основной 

капитал и других финансовых показателей;  

o  Дата и время (Date & Time) — операции прямого и 

обратного преобразования даты и времени в тексто-

вые строки. 

o  Математические (Math & Trig) — математические и 

тригонометрические функции;  

o Статистические (Statistical) — функции для расчета 

среднего значения, дисперсии, статистических рас-

пределений и других вероятностных характеристик;  

o  Ссылки и массивы (Lookup & Reference) — опера-

ции преобразования ссылки на ячейку в число, рас-

чета ссылок на основе числовых аргументов, вы-

числения числа строк и столбцов диапазона и дру-

гих параметров, связанных с адресацией ячеек листа 

Excel;  

o  Работа с базой данных (Database) — функции фор-

мирования выборки из базы данных и расчета ста-

тистических параметров величин, расположенных в 

базе данных;  

o  Текстовые (Text) — функции для работы с тексто-

выми строками.  

o Логические (Logical) — шесть функций для работы 

с данными логического типа, то есть величинами 

или условиями, принимающими значение Истина 

или Ложь;  

o  Проверка свойств и значений (Information) — 

функции проверки типа данных аргумента, режима 

форматирования ячейки, типа сгенерированной 

ошибки и других специальных условий.  

 В списке Категория (Function Category) есть также пункты 

Рекомендуемый перечень (Recommended), Полный алфавитный 

перечень (All) и 10 недавно использовавшихся (Most Recently 
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Used), которые выводят соответственно список всех функций и 10 

функций, применявшихся последними.  

3.  Выберите в списке Категория окна диалога вставки функ-

ций (см. рис. 2.2) пункт Статистические.  

4.  Выберите в списке Функция (Function Name) пункт МАКС.  

5.  Щелкните на кнопке ОК. Откроется окно ввода диапазона 

ячеек, показанное на рис. 2.3.  

 
Рис. 2.3. Окно ввода аргументов  

 

 Некоторые функции, например SIN, имеют только один ар-

гумент, поскольку нельзя вычислить синус сразу двух чисел. Одна-

ко многие функции, подобные МАКС, способны обрабатывать 

практически неограниченные массивы данных. Такие функции мо-

гут воспринимать до 30 аргументов, каждый из которых является 

числом или ссылкой на одну или несколько ячеек.  

Примечание  
В качестве аргументов могут выступать также арифметические вы-

ражения и другие функции, возвращающие значения нужного типа.  

С помощью функции МАКС вы сейчас найдете максимальный уро-

вень продаж за один месяц для компаний Фантом, РИФ и Викинг.  

 

 
Рис. 2.4. Выбор ячеек для первого аргумента  
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6.  Щелкните на кнопке в правой части поля Число 1 (Number 

1). Окно диалога свернется в строку, открывая доступ к 

ячейкам листа.  

7.  Выделите все числовые ячейки строки Фантом. Обозначе-

ние соответствующего диапазона ячеек появится в строке 

свернутого окна диалога ввода аргументов (рис. 2.4).  

8. Щелкните на кнопке строки аргумента. На экране снова 

развернется окно ввода аргументов.  

9.  Щелкните на кнопке в правой части поля Число 2 (Number 

2).  

10.  Выделите ячейки B4:G4 и снова щелкните на кнопке стро-

ки ввода аргумента. Поскольку вы ввели уже два аргумента, 

Excel автоматически добавит поле ввода третьего.  

11.  Введите в поле Ч и ел о 3 (Number 3), как показано на рис. 

2.5, текст B6:G6. Это диапазон нужных ячеек строки Ви-

кинг. В окне диалога правее полей с аргументами демон-

стрируются их реальные значения. Ниже списка чисел 

отображается результат вычислений.  

 

 
Рис. 2.5. Три диапазона ячеек в качестве аргументов функции МАХ  

 

12.  Щелкните на кнопке ОК. В ячейке 18 появится максималь-

ное число из диапазона, записанного в строках 2,4 и 6. Сама 

формула появится в строке формул в верхней части окна 

Excel. Щелкните в этой строке. Три аргумента функции 

МАКС, задающие три диапазона ячеек, будут выделены 
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разными цветами, а соответствующие группы ячеек листа 

Excel окажутся обведенными рамками соответствующих 

цветов, как показано на рис. 2.6.  

 

 
Рис. 2.6. Группы ячеек, выступающие в качестве 

аргументов формулы  

Примечание  
Если вы хорошо знакомы с синтаксисом функций и формул Excel, 

то можете просто вводить формулы в ячейки, как это делалось на 

предыдущем занятии, не пользуясь окнами диалога выбора функ-

ции и ввода аргументов.  
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2.3 Упражнение 3. Диапазон ячеек  

 Для ссылки на данные ячеек листа в Excel используются 

имена клеток, состоящие из буквы столбца (или двух букв, если 

столбцов больше 26) и номера строки. Так как многие функции мо-

гут воспринимать в качестве аргументов целые массивы данных, 

нужно выучить правила ссылок на такие массивы.  

1.  Щелкните на ячейке Н9 и введите текст Сумма. Затем 

нажмите клавишу Tab.  

2. Введите символы =СУММ () (=SUM ()). Эта формула вы-

числяет сумму всех величин, указанных в скобках в каче-

стве аргумента.  

3. Щелкните в строке формул и поместите курсор между дву-

мя скобками.  

4.  Введите в скобки текст В: В.  

5.  Щелкните на кнопке Ввод слева от строки формул. В ячей-

ке 19 появится сумма всех ячеек столбца В, так как симво-

лы В:В обозначают все ячейки столбца В.  

6.  Снова щелкните в строке формул. В таблице окажется вы-

деленной та группа ячеек, которые описываются аргумен-

том В: В, как показано на рис. 2.7.  

7.  Повторите шаги с 3-го по 6-й, поочередно вводя в скобки 

формул значения из первого столбца табл. 2.1. Изучите, ка-

кие диапазоны ячеек соответствуют указанным условным 

обозначениям. Немного потренировавшись, вы сможете 

указывать в качестве аргумента 4>ункции любые группы 

ячеек листа. , Если в разных формулах часто приходится 

ссылаться на одну и ту же группу ячеек, особенно если в 

группу входят разрозненные ячейки из разных областей ли-

ста, ей удобно присвоить специальное имя.  

8.  Протаскиванием мыши выделите ячейки B3:G3.  

9.  Нажмите клавишу Ctrl и протащите указатель мыши по 

ячейкам B5:G5.  

10.  Введите в поле Имя (Name Box) слово Строки, как показа-

но на рис. 2.8.  Нажмите клавишу Enter.  

11.  Щелкните на ячейке 19, введите формулу =СУММ(Строки) 

(=SUМ(Строки)) и нажмите клавишу Enter. В ячейке 19 по-

явится сумма двенадцати ячеек строк 3 и 5.   
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Рис. 2.7. Столбец В в качестве аргумента функции  

 

ТАБЛИЦА 2.1 .Способы ссылки на группы ячеек  

Обозначение  Группа ячеек  

F3  Ячейка на пересечении столбца F и строки-3  

Е10:Е20  Ячейки с 10-й по 20-ю в столбце Е  

В15:Е15  Ячейки с В по Е в строке 15  

5:5  Все ячейки строки 5  

5:10  Все ячейки строк с 5-й по 10-ю  

В:В  Все ячейки столбца В  

B:J  Все ячейки столбцов c B no J  

А10:Е20  
Прямоугольная область пересечения строк с 10-й 

по 20-ю и столбцов с А по Е  
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Рис. 2.8. Именованная группа ячеек  

12.  Щелкните на стрелке раскрывающегося списка Имя (Name 

Box).  

13. Выберите пункт Строки. Окажутся выделенными ячейки 

диапазона Строки. Таблица может содержать несколько 

именованных диапазонов ячеек. Такие именованные диапа-

зоны значительно упрощают формулы, делая их более 

наглядными.  
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2.4 Упражнение 4. Копирование формул  

 Иногда требуется провести одинаковые расчеты с разными 

группами ячеек. В такой ситуации можно сэкономить время и ско-

пировать формулы, так как Excel поддерживает относительную ад-

ресацию ячеек. В строке 10 нашего примера уже есть формулы, 

рассчитывающие относительный прирост продаж по месяцам для 

клиента Фантом. Давайте скопируем их, чтобы получить таблицу 

прироста продаж для всех клиентов.  

1.  Щелкните на любой непустой ячейке в строке 10. Вы уви-

дите, что выбранная формула ссылается на ячейки строки 2.  

2.  Выделите диапазон B10:F10.  

3.  Нажатием клавиш Ctrl+C скопируйте ячейки.  

4. Щелкните на ячейке В11, а затем на кнопке Вставить пане-

ли инструментов Стандартная. Появится еще одна строка 

ячеек с формулами. Щелкните на любой из них и взгляните 

в строку формул. Вы увидите, что формулы новых ячеек 

ссылаются на данные строки 3, как показано на рис. 2.9.  

5.  Щелкните на ячейке В 12 и нажмите клавиши Ctrl+V, что-

бы вставить еще одну строку. Формулы этой строки уже 

будут ссылаться на данные строки 4. Таким образом, номе-

ра ячеек данных изменяются ровно на столько клеток, на 

сколько смещается вставляемая формула.  

 
Рис. 2.9. Копирование формул  
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Примечание  
Обратите внимание, что вырезание ячеек с формулами с последу-

ющей их вставкой в другое место листа никак не изменяет ссылки 

на данные.  

6.  Вставьте тот же самый фрагмент в ячейки В13 и В14.  

7.  Скопируйте заголовки строк из ячеек А2:А6 в ячейки 

А10:А14.  

Примечание  
Обычно Excel формирует относительные ссылки на ячейки. Но 

иногда нужно сослаться в формуле на клетку с константой, которая 

не должна меняться при копировании формулы в другую ячейку 

или при перемещении исходных данных. В этом случае пользуй-

тесь абсолютными ссылками, которые отличаются от относитель-

ных наличием символа $ перед буквой столбца, номером строки 

или перед обеими этими характеристиками, например $Е$15. В та-

кой ссылке не изменяется та часть, перед которой стоит знак $. 

Например, копируя формулу =СУММ($В$2:$0$6) 

(=SUM($B$2:$G$6)) в другую ячейку, вы получите тот же самый 

результат, что и в исходной клетке формулы.  

Операция суммирования строк или столбцов — одна из наиболее 

распространенных. Чтобы создать формулы сумм строк или столб-

цов, не нужно даже копировать ячейки, Excel предлагает еще более 

быстрый способ.  

8.  Выделите группу ячеек 12:16.  

9. Щелкните на кнопке Автосумма (AutoSum) панели инстру-

ментов Стандартная.  

10. Осталось только ввести в ячейку II заголовок Итого, и 

столбец общей суммы продаж для всех пяти клиентов готов 

(рис. 2.10).  

Примечание    

Обратите внимание на значок вставки, появляющийся в правом 

нижнем углу вставленного фрагмента. Благодаря ему легко вы-

брать вариант вставки — хотите ли вы вставить число из копируе-

мой ячейки или абсолютную либо относительную ссылки, нужно 

ли сохранять формат исходной ячейки и т. д.  
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2.5 Упражнение 5. Поиск ошибок  

 По мере изучения формул и функций Excel вы, конечно же, 

будете делать ошибки. Это может быть неверно заданный диапазон 

ячеек, неправильное имя функции или просто пропущенная скобка. 

Excel зафиксирует ошибку и в случае неверного типа аргумента, 

если, к примеру, в ячейке вместо ожидаемой числовой величины 

оказалась текстовая.  

 
Рис. 2.10. Автосумма  

 

1.  ЩелкнитенаячейкеШивведитеформулу СРЗНАЧ B11:F11 

(AVERAGE B11:F11).   

2.  Нажмите клавишу Enter. В ячейке появится сообщение 

#ИМЯ (#NAME), которое \ указывает на ошибку в имени 

функции. Слева от него находится маленький значок по-

мощника, содержащий раскрывающийся список, в котором 

приводятся возможные способы устранения ошибки. . В 
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табл. 2.2 приведен список сообщений об ошибках, которые 

можно встретить в ячейках при работе с формулами.  

3.  Чтобы исправить формулу, двойным щелчком на ячейке 

111 перейдите в режим редактирования формулы.  

Примечание  
Инструмент автокоррекции формул сам исправляет наиболее оче-

видные ошибки. Например, если в рассматриваемой формуле вы 

забудете ввести только закрывающую скобку, программа сама до-

бавит ее.  

ТАБЛИЦА 2.2. Сообщения об ошибках в формулах  

4.  Измените содержимое ячейки так, чтобы получилась фор-

мула СРЗНАЧ (В 11:F11) (AVERAGE(B11:F11)).  

 

Сообщение  Описание ошибки  

#####  

Ширина ячейки недостаточна для отображе-

ния результата вычисления или отрицатель-

ный результат вычислении в ячейке, отформа-

тированной как данные типа даты или време-

ни  

#ЗНАЧ 

(#VALUE!)  

Неверный тип аргумента или операнда. 

Например, указание в качестве аргумента 

ячейки с текстом, когда требуется число  

#ДЕЛ/0(#01У/0!)  Деление на 0  

#ИМЯ (#NAME!)  
Excel не может распознать текст, введенный в 

формулу, например неверное имя функции  

#Н/Д (#N/A)  
Данные ячейки одного из аргументов форму-

лы в данный момент недоступны  

*#ССЫЛКА 

(#REF!)  
Неверная ссылка на ячейку  

#ЧИСЛО(#МиМ!)  

Невозможно вычислить результат формулы, 

либо он слишком велик или мал для коррект-

ного отображения в ячейке  

#ПУСТО 

(#NULL!)  

Результат поиска пересечения двух непересе-

кающихся областей, то есть неверная ссылка  
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2.6 Упражнение 6. Применение функций  

 До сих пор вы пользовались только функциями СУММ, 

СРЗНАЧ, СЧЕТ и МАКС. Давайте рассмотрим на примере некото-

рые функции из разряда текстовых и логических, а также функции 

работы с датой и временем. Результат всех вычислений, которые 

будут выполнены в этом упражнении.  

1.  В листе Формулы выделите и скопируйте ячейки Bl:Gl.  

2.  Разверните лист ЛистЗ (Sheet3).  

3.  Щелкните правой кнопкой мыши на ячейке А1 и выберите 

в контекстном меню команду Вставить.  

4. Введите в ячейку A3 формулу =ЛЕВСИМВ(А1 ;3) 

(=LEFT(A1; 3)). Эта формула возвращает три левых симво-

ла ячейки А1.  

5.  Перетащите угловой маркер выделения вправо, чтобы рам-

ка охватила ячейки A3:F3. Теперь в третью строку выводят-

ся сокращенные варианты названий месяцев из ячеек пер-

вой строки.  

6.  Щелкните наячейкеНЗ и введите формулу =СЦЕПИТЬ(ВЗ 

;D3) (CONCATENATE (ВЗ ; D3)). В ячейке НЗ появится 

объединение строк Фев и Апр.  

7.  В ячейку А8 введите формулу =ТДАТА () (=NOW ()) и 

нажмите клавишу Enter. В ней тут же появятся текущие да-

та и время.  

8.  Введите в ячейки с В8 по В13 формулы = ГОД (А8) 

(=YEAR(A8)), =МЕСЯЦ(А8) (=MONTH 

(А8)),=ДЕНЬ(А8)(=DAY(А8)),=ЧАС(А8)(=HOUR(A8)),=М

ИНУТЫ(А8) (=MINUTE(A8)) и =СЕКУНДЫ(А8) 

(=SECOND (A8)). В этих ячейках появятся по отдельности 

все шесть компонентов текущих даты и времени.  

9.  Дважды щелкните на ячейке А8, чтобы перевести ее в ре-

жим редактирования.  

10.  Щелкните на кнопке Ввод, расположенной слева от строки 

формул. Эта операция приведет к обновлению значения в 

ячейке А8, что повлияет и на числа ячеек В8:В13.  

Теперь давайте выполним логическую операцию.  

11. ВведитевячейкуА4формулу=ЕСЛИ(АЗ="Фев"; "Да"; "Нет") 

(=IF(АЗ="Фев"; " Да "; " Н е т ")). Эта операция сравнивает 
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значение ячейки A3 с текстовой строкой Фев. В случае ра-

венства выводится текст второго аргумента — Да. В случае 

неравенства выводится текст третьего аргумента — Нет. 

Так как в ячейке A3 присутствует текст Янв, то результатом 

этой операции будет значение Нет.  

12.  Растяните маркер ячейки А4 вправо, чтобы рамка охватила 

диапазон A4:F4. Теперь формулы строки 4 проверяют ячей-

ки строки 3 на совпадение их содержимого со строкой Фев. 

Как видите, слово Да появилось только в столбце В.  

 Знаки, которые используются в Excel для сравнения вели-

чин, перечислены в табл. 2.3. Обратите внимание, что текстовые 

строки, выступающие в качестве аргументов функций, должны за-

ключаться в двойные кавычки.  

Примечание  
Текстовые строки равны, если попарно совпадают все их символы, 

в противном случае строки не равны. Одна текстовая строка боль-

ше другой, если в ней код первого символа, несовпадающего в обе-

их строках, больше кода того же символа во второй строке.  

 

ТАБЛИЦА 2.3. Знаки сравнения  

 

Знак  Значение   

=  Равно  

>  Больше  

<  Меньше  

>=  Больше или равно  

<=  Меньше или равно  

<>  Не равно  
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2.7 Контрольное упражнение  

1.  В файле электронная таблица .xls раскройте лист Кален-

дарь, созданный в контрольном упражнении  предыдущего 

занятия   

2. Щелкните в ячейке G3, введите формулу, вычисляющую 

среднее значение чисел строки 3 календаря, и нажмите кла-

вишу Enter.  

3.  В ячейку НЗ выведите целую часть этого среднего значе-

ния.  

o С помощью какой функции выделяется целая часть 

числа ?  

4.  Продублируйте две полученные формулы во всех строках 

календаря.  

o Как продублировать формулы двух ячеек в не-

скольких строках?  

5.   В ячейке Gil сосчитайте сумму средних значений, а в 

ячейке Н11 с помощью функции ПРОИЗВЕД произведение 

целых частей средних значений.  

6.  В ячейке F11 с помощью функции СУМ М подсчитайте 

сумму всех ячеек третьей и четвертой строк листа Excel.  

o   Как задать в качестве аргумента функции две 

строки листа ?  

7.   Скопируйте содержимое ячейки F11.  

8.  Щелкните на ячейке F13 и вставьте в нее формулу из бу-

фера обмена.  

o Сумму каких ячеек подсчитывает вставленная фор-

мула?  
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ГЛАВА 3. MICROSOFT ACCESS 

 
 Microsoft Access XP — профессиональная программа 

управления базами данных. С ее помощью можно накапливать и 

систематизировать разнообразную информацию, искать и сортиро-

вать объекты согласно выбранным критериям, конструировать 

удобные формы для ввода данных и генерировать на основании 

имеющихся записей прекрасно оформленные отчеты. Access обес-

печивает одновременный доступ к данным десяткам пользовате-

лей. 

 Базы данных — это совокупность структур, предназначен-

ных для хранения больших объемов информации и программных 

модулей, осуществляющих управление данными, их выборку, сор-

тировку и другие подобные действия. Информация базы данных 

хранится в одной или нескольких таблицах. Любая таблица с дан-

ными состоит из набора однотипных записей, расположенных друг 

за другом. Они представляют собой строки таблицы, которые мож-

но добавлять, удалять или изменять. Каждая запись является набо-

ром именованных полей, или ячеек, которые могут хранить самую 

разнообразную информацию, начиная от даты рождения и заканчи-

вая подробным описанием кулинарного рецепта. Однотипные поля 

разных записей образуют столбец таблицы. 

 Записи одной таблицы могут содержать ссылки на данные 

другой таблицы, например, в таблице со списком товаров могут 

храниться ссылки на справочник производителей товаров с их ад-

ресами и другими реквизитами. При этом записи, касающиеся раз-

ных товаров, могут указывать на одного и того же производителя. 

Такое взаимодействие таблиц называется связью. 

 Другие модули базы данных предназначены для обработки 

информации, хранящейся в таблицах. С помо-

щью запросов производится выборка данных, отвечающих опреде-

ленным условиям. Формы предназначены для форматированного 

ввода и восприятия информации. Отчеты обеспечивают вывод 

(как правило, на принтер) красочно оформленного списка записей с 

заголовками, пунктами и подпунктами. 
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3.1 Упражнение 1. Мастер таблиц 

 С помощью мастера таблиц можно создавать некоторые 

часто встречающиеся структуры данных. Прежде чем заново стро-

ить структуру таблицы, подумайте, нельзя ли воспользоваться од-

ним из стандартных шаблонов мастера таблиц. Это позволит сэко-

номить время. Например, чтобы создать таблицу данных, предна-

значенную для хранения списка людей, с которыми вы контактиру-

ете, выполните следующие действия. 

1.  Запустите Microsoft Access, выполнив соответствующую 

команду меню Пуск > Программы (Start > Programs). 

2.  В появившемся в области задач приложения окне Создание 

файл? (New File) в разделе Создание (New) щелкните на 

пункте Новая база данных (Blank Access Database) (рис. 

3.1). Откроется окно диалога Файл новой базы данных (File 

New Database). 

 

 
Рис. 3.1. Окно Microsoft Access 
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3. Выберите для размещения новой базы данных папку Мои 

документы (My Documents). В поле Имя файла (File Name) 

введите имя Контакты. Затем щелкните па кнопке Создать 

(Create). 

Примечание 
После своего создания файл базы данных обновляется автоматиче-

ски при закрытии и выполнении некоторых критических операций 

(например, изменении структуры таблицы). Нет необходимости 

вручную сохранять файл, хотя при долгой работе это следует де-

лать во избежание потерь данных из-за сбоя компьютера. 

Откроется окно базы данных, показанное на рис. 3.2. Оно является 

основным окном базы и позволяет открывать, добавлять и удалять 

любые объекты базы данных. В левой области окна находятся 

кнопки групп объектов. В его правой части расположен список 

объектов выбранного типа, имеющихся в текущей базе данных, а 

также значки команд, позволяющих создавать новые объекты дан-

ного типа. Пока что в этой базе данных нет ни одного объекта. 

4.  Щелкните на кнопке Таблицы (Tables). 

5.  Чтобы запустить мастер создания таблиц, дважды щелкни-

те на значке Создание таблицы с помощью мастера (Create 

Table By Using Wizard). 

 

 
Рис. 3.2. Окно базы данных 
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 В первом окне мастера, показанном на рис. 3.3, нужно ука-

зать подходящую структуру и выбрать в ней необходимый набор 

полей. 

6. Выберите положение переключателя Деловые (Business). 

7. В списке Образцы таблиц (Sample Tables) выберите пункт 

Контакты (Contacts). 

8. Щелкните на пункте Имя (FirstName) списка Образцы по-

лей (Sample Fields). 

9.  Щелкните на кнопке со стрелкой вправо, чтобы добавить 

выбранное поле в структуру создаваемой таблицы. 

10.  Повторяя шаги 8 и 9, добавьте в список Поля новой табли-

цы (Fields In My New Table) поля Фамилия (LastName), Ад-

рес (Address), НазваниеКомпании (Company Name) и Рабо-

чийТелефон (WorkPhone). 

11.  Щелкните на кнопке Далее (Next). 

12. В поле второго окна мастера введите слово Контакты, ко-

торое будет играть роль имени таблицы. Затем щелкните на 

кнопке Далее. 

 

 
Рис. 3.3. Мастер создания таблиц 

 

13.  В третьем окне мастера щелкните на кнопке Готово 

(Finish). Мастер сгенерирует таблицу и откроет ее в режиме 

ввода данных. 
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 Обратите внимание: поскольку во втором окне осталось 

выбранным положение переключателя Microsoft Access автомати-

чески определяет ключ (Yes, Set A Primary Key For Me), Access до-

бавляет в таблицу дополнительное ключевое поле Код_ Контакты 

(КонтактыЮ), которое играет роль уникального идентификатора 

записей. 

3.2 Упражнение 2. Таблицы  

 Таблица данных похожа на лист электронной таблицы, но 

ее размеры ограничены. Число ее строк на единицу больше количе-

ства записей (последняя пустая строка предназначена для ввода 

новой записи), а число столбцов равно количеству полей в записи. 

Заголовки столбцов таблицы соответствуют именам полей, сфор-

мированных с помощью мастера создания таблиц.  

1.  Щелкните на поле Имя и введите какое-нибудь имя. Access 

автоматически добавит в таблицу, созданную на предыду-

щем упражнении, первую запись, а строка новой записи 

сместится вниз.  

2. Введите фамилию в поле Фамилия.  

3.  Заполните все остальные поля первой записи.  

4.  Щелкните на поле Имя последней строки и введите имя 

еще одного человека, его фамилию, адрес, название компа-

нии и телефон. Добавьте подобным образом несколько за-

писей, чтобы таблица стала такой, как показано на рис. 3.4. 

Если вы ошиблись при вводе, просто щелкните на ячейке с 

неверными данными и отредактируйте их. Стандартные за-

головки столбцов часто оказываются неудобными, поэтому 

Access позволяет заменять их.  

 
Рис. 3.4. Таблица данных  

 

5.  Щелкните на заголовке Фамилия правой кнопкой мыши и 

выберите команду Переименовать (Rename).  
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6.  Введите слово Название, которое заменит подсвеченный 

заголовок Фамилия.  

7.  Повторив шаги 5 и 6, верните столбцу название Фамилия.  

8. Щелчком на кнопке Первая запись (First Record) переме-

стите указатель теку щей записи в начало таблицы.  

9. Два раза щелкните на кнопке Следующая запись (Next 

Record), чтобы перейти к четвертой записи.  

10. Щелкните на кнопке Удалить запись (Delete Record) панели 

инструментов.  

11.  В появившемся окне запроса, информирующем о невоз-

можности отмены операции удаления записи, щелчком на 

кнопке Да (Yes) подтвердите необходимость удаления. Об-

ратите внимание, что ключевое поле Код_Контакты авто-

матически заполняется некоторыми числами. Эти числа не 

обязательно образуют непрерывную последовательность. 

Единственным условием является их уникальность. Содер-

жимое ключевого поля различно для всех записей таблицы, 

что позволяет однозначно идентифицировать запись. Такие 

поля используются для формирования связей таблиц, о ко-

торых вы узнаете на этом занятии позже.  

3.3 Упражнение 3. Структура таблицы  

 В упражнении 1 была создана таблица для хранения данных 

о людях, с которыми вы контактируете. Теперь давайте с помощью 

конструктора добавим в базу данных еще одну таблицу, предна-

значенную для записи всех случаев контакта с людьми из первой 

таблицы.  

1.  Щелчком на кнопке Окно базы данных (Database Window) 

переключитесь на список таблиц базы данных.  

2. Дважды щелкните на значке Создание таблицы в режиме 

конструктора (Create Table In Design View). Окно конструк-

тора, показанное на рис. 3.5, состоит из двух частей. В 

верхней отображается список полей таблицы, а в нижней — 

свойства выделенного поля.  

3.  Введите слово Дата, которое будет играть роль названия 

нового поля.  
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4. Щелкните на ячейке Тип данных (Data Type) первой строки 

списка полей. Здесь необходимо выбрать тип поля, который 

определяет структуру и размер данных.  

 
Рис. 3.5. Конструктор таблиц  

 

5. Щелкните на появившейся стрелке раскрывающегося спис-

ка ячейки Тип данных и выберите пункт Дата/время 

(Date/Time).  

6.  Нажмите клавишу Tab и введите расшифровку назначения 

поля: Дата контакта. Такие описания вводить не обязатель-

но, но их наличие помогает разобраться в структуре табли-

цы.  

7.  Щелкните на второй ячейке столбца Имя поля (Field Name) 

и введите имя Описание.  

8. Задайте для второго поля тип Текстовый (Text).  

9. Укажите назначение поля в соответствии с рис. 3.5.  

Кроме даты и описания контакта таблица данных должна содер-

жать информацию о том, с кем вы контактировали. Но список лю-

дей хранится в таблице Контакты, поэтому в новой таблице не 

нужно заново вводить имя и фамилию. Достаточно лишь добавить 

ссылку на одну из записей таблицы Контакты. Эта ссылка будет 

иметь числовой тип и содержать число, равное значению поля 

Код_Контакты соответствующей записи таблицы Контакты.  

10.  Добавьте еще одно поле с именем Код_Контакты и типом 

Числовой (Number),  
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 Теперь нужно добавить индексированное поле и назначить 

его ключом, однозначно' идентифицирующим записи таблицы. Ин-

дексированные поля, или индексы, отличаются от обычных тем, 

что для них Access создает специальные списки, позволяющие вы-

полнять быструю сортировку и поиск по содержимому индексиро-

ванного поля. Таблица может содержать несколько индексов. Ключ 

— это специальный индекс, идентифицирующий записи. Значения 

такого поля должны быть уникальными. Его наличие не обязатель-

но, но оно так часто используется, что при отсутствии ключа 

Access напоминает об этом и предлагает автоматически добавить 

ключевое поле.  

11. Добавьте поле Ключ и назначьте ему тип Счетчик 

(AutoNumber). Такой тип данных избавляет пользователя от 

необходимости ввода значений ключевого поля и иниции-

рует автоматическую генерацию уникальных значений.  

12.  Сохраняя активной строку Ключ, щелкните на кнопке 

Ключевое поле (Primary Key). На кнопке этой строки по-

явится значок ключа, показывающий особый статус поля.  

13.  Щелкните на кнопке закрытия окна конструктора.  

14.  Access спросит о необходимости сохранения структуры 

таблицы. В ответ щелкните на кнопке Да.  

15.  В открывшемся окне диалога (рис. 3.6) введите имя Спи-

сок.  

 
Рис. 3.6. Ввод имени таблицы  

 

16.  Щелкните на кнопке ОК.  
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3.4 Упражнение 4. Список подстановки  

 Пришло время наполнить таблицу Список конкретной ин-

фрмацией. Для этого выполните следующие шаги.  

1. В окне базы данных откройте список таблиц и дважды 

щелкните на значке Список. Выбранная таблица откроется 

в режиме просмотра данных.  

2.  Добавьте несколько записей в соответствии с рис. 3.7.  

 
Рис. 3.7. Список состоявшихся контактов  

 

Примечание  
Чтобы расширить столбец Описание, содержащий длинные тексто-

вые строки, поместите указатель мыши на его правую границу и, 

когда значок сменится на двунаправленную стрелку, перетащите 

границу вправо.  

 Не забывайте, что числа в столбце Код_Контакты должны 

соответствовать номерам записей таблицы Контакты, описываю-

щих людей, с которыми вы контактировали. Согласитесь, что ис-

кать соответствующие номера очень неудобно. Access позволяет 

автоматизировать эту операцию с помощью списка подстановки, 

который настраивается следующим образом.  

3.  Щелкните на кнопке Вид (View) панели инструментов. От-

кроется окно конструктора таблицы.  

4.  В списке типа данных для поля Код_Контакты выберите 

пункт Мастер подстановок (Lookup Wizard).  

5.  В первом окне мастера оставьте выбранным положение пе-

реключателя Объект «столбец подстановки» будет исполь-
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зовать значения из таблицы или запроса (I Want The Lookup 

Column To Look Up The Values In The Table Or Query) и 

щелкните на кнопке Далее. Три положения переключателя 

второго окна мастера выводят на экран список таблиц, за-

просов или объединяют эти два списка. Здесь нужно вы-

брать таблицу или запрос на роль источника подстановки. 

В нашем случае база данных кроме таблицы Список содер-

жит только один объект — таблицу Контакты, которая и 

окажется выбранной в окне мастера.  

6.  Щелкните на кнопке Далее. Третье окно мастера, показан-

ное на рис. 3.8, предлагает выбрать из таблицы Контакты 

поля, участвующие в подстановке. Этот список обязан со-

держать то поле, значения которого должны помещаться в 

поле Код_Контакты, то есть одноименное поле таблицы 

Контакты.  

7.  Щелкните на пункте Код_Контакты.  

 
Рис. 3.8. Мастер подстановок  

 
Рис. 3.9. Параметры подстановки  
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8.  Щелкните на кнопке со стрелкой вправо. В список источ-

ника подстановки следует также добавить те поля, содер-

жимое которых должно отображаться вместо численного 

значения, помещаемого из поля Код_Контакты таблицы 

Контакты в поле Код_Контакты таблицы Список. Я думаю, 

что будет удобно выбирать людей по их именам и фамили-

ям.  

9.  Добавьте в список Выбранные поля (Selected Fields) пунк-

ты Фамилия и Имя.  

10.  Затем щелкните на кнопке Далее.  

11.  В следующем окне мастер продемонстрирует два столбца 

таблицы-источника, скрыв столбец Код_Контакты, содер-

жащий идентификатор записи. Щелкните на кнопке Далее.  

12.  В поле последнего столбца введите название Контакт, ко-

торое заменит имя столбца Код_Контакты, и щелкните на 

кнопке Готово.  

13.  В появившемся окне диалога щелчком на кнопке Да под-

твердите необходимость сохранения построенной структу-

ры.  

Примечание  
Параметры списка подстановки появятся на вкладке Подстановка 

(Lookup), показанной на рис. 3.9. Если вы знакомы с языком струк-

турированных запросов SQL, то сможете разобраться в запросе Ис-

точник строк (Row Source), который формирует таблицу подста-

новки.  

14. Щелкните на кнопке Вид, чтобы снова переключиться в 

режим ввода данных.  

 Теперь в третьем столбце таблицы вместо чисел видны фа-

милии, соответствующие этим числам, хотя само значение поля 

Код_Контакты не изменилось. Access автоматически ищет соответ-

ствующую запись таблицы Контакты по числу, содержащемуся в 

поле Код_Контакты, и выводит в ячейку текст поля Фамилия — 

второго поля таблицы Контакты из выбранных в окне мастера под-

становки. Давайте попробуем добавить в таблицу Список еще одну 

запись.  
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Рис. 3.10. Список подстановки  

 

15.  Щелкните на нижней ячейке столбца Дата и введите дату 

10.10.97.  

16.  Нажмите клавишу Tab и напечатайте текст Письмо с пред-

ложениями о сотрудничестве.  

17.  Снова нажмите клавишу Tab и щелкните на появившейся 

кнопке раскрывающегося списка, как показано на рис. 3.10. 

Теперь вы можете выбирать людей из списка подстановки, 

сформированного на базе полей Фамилия и Имя таблицы 

Контакты.  

18.  Щелкните на втором пункте списка.  

 Access автоматически отыщет в таблице Контакты значение 

поля Код_Контакты для записи, содержащей информацию о Петре 

Петрове, и введет найденное число в поле Код_Контакты таблицы 

Список. Это значение останется скрытым. Вместо него в ячейке 

таблицы Список появится соответствующая фамилия, взятая из 

таблицы Контакты.  
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3.5 Упражнение 5. Связь таблиц  

 В предыдущем упражнении с помощью мастера подстано-

вок была сформирована связь между двумя таблицами. Такая связь 

позволяет установить правила взаимодействия между таблицами. 

Список подстановок можно было организовать и без связи. Но 

представьте, что вы удалите из таблицы Контакты запись, на кото-

рую ссылаются некоторые записи таблицы Список. В такой ситуа-

ции останутся описания контактов, фамилии людей в которых по-

теряны. Наличие правильно организованной связи позволяет избе-

жать подобных неприятностей.   

1. Выберите команду Сервис > Схема данных (Tools > 

Relationships). Откроется окно, схематически изображаю-

щее связи базы данных. На рис. 3.11 видно, что линия связи 

соединяет поля Код_Контакты таблицы Контакты и Кон-

такт таблицы Список.  

Примечание  
Данная связь соединяет ключевое и обычное поля. Это связь типа 

«один ко многим», когда одной записи таблицы Контакты может 

соответствовать несколько записей таблицы Список, но не наобо-

рот.  

 
Рис. 3.11. Схема данных  

 

Для тренировки давайте удалим связь, а затем создадим ее заново.  

2.  Щелчком выделите линию связи.  

3.  Нажмите клавишу Delete. В ответ на появившийся запрос 

щелкните на кнопке Да. Связь исчезнет.  
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4.  Поместите указатель мыши на пункт Код_Контакты табли-

цы Контакты.  

5.  Нажмите кнопку мыши и перетащите указатель на поле 

Контакт таблицы Список.  

6.  В открывшемся окне диалога щелкните на кнопке Создать. 

Связь появится вновь.  

Чтобы настроить параметры связи, выполните следующие шаги.  

7.  Дважды щелкните на линии связи. Откроется окно диалога, 

показанное на рис. 3.12.  

 
Рис. 3.12. Параметры связи  

 

Примечание  
Если таблицы, между которыми нужно организовать связь, отсут-

ствуют, щелкните в окне Схема данных (Relationships) правой 

кнопкой мыши и выберите команду Добавить таблицу (Show 

Table). В открывшемся окне диалога выделяйте таблицы, которые 

нужно разместить в окне Схема данных и щелкайте на кнопке До-

бавить (Add). Получив все необходимые таблицы, закройте окно 

диалога кнопкой Закрыть (Close).  

8.  Установите флажок Обеспечение целостности данных 

(Enforce Referential Integrity). Этот режим не позволит 

Access оставлять в таблице Список записи, для которых 

нельзя подобрать запись таблицы Контакты с подходящим 

значением поля Код_Контакты.  
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9.  Установите флажок Каскадное удаление связанных запи-

сей (Cascade Delete Related Records). Теперь при удалении 

записи таблицы Контакты (то есть удалении информации о 

конкретном человеке) будут удалены все соответствующие 

записи таблицы Список (то есть все описания контактов с 

этим человеком). Если указанный флажок сброшен, удале-

ние тех записей таблицы Контакты, на которые ссылается 

хотя бы одна запись таблицы Список, запрещено.  

Примечание  
Установка флажка Каскадное обновление связанных полей приве-

дет к тому, что при обновлении поля Код_Контакты таблицы Кон-

такты будут автоматически обновляться одноименные поля в соот-

ветствующих записях таблицы Список.  

10.  Щелкните на кнопке ОК.  

11.  Закройте окно Схема данных.  

12.  В окне базы данных дважды щелкните на значке таблицы 

Контакты. В открывшемся окне таблицы видны небольшие 

знаки «плюс», расположенные в левой части записей. Их 

присутствие говорит о наличии связи ключевого поля таб-

лицы с другой таблицей.  

13. Щелкните на знаке «плюс» записи для Петра Петрова. От-

кроется вложенная таблица, содержащая те записи таблицы 

Список, значение поля Код_Кон-такты которых равно ве-

личине одноименного поля записи для Петра Петрова (рис. 

3.13).  

Примечание  
При раскрытии фрагмента связанной таблицы знак «плюс» пре-

вращается в знак «минус». Чтобы скрыть дополнительную таблицу, 

щелкните на нем еще раз.  

14.  Щелкните еще на каком-нибудь знаке «плюс», и вы увиди-

те описание всех контактов с еще одним человеком. Таким 

образом, с помощью созданной связи вы можете быстро 

просматривать в окне таблицы Список описания всех кон-

тактов с определенным человеком или группой лиц.  
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Рис. 3.13. Выборка данных из связанной таблицы  

3.6 Упражнение 6. Параметры поля  

 Для того, чтобы обеспечить возможность хранения в базе 

данных разнообразной информации, Access предлагает большой 

набор типов данных, перечисленных в табл. 3.1.  

 Чтобы сделать работу со списком контактов более продук-

тивной, следует изменить типы данных некоторых полей.  

1. В окне базы данных выделите таблицу Список и щелкните 

на кнопке Конструктор (Design), расположенной в верхней 

части окна. Выбранная таблица откроется в режиме кон-

структора.  
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2.  Описание контакта может быть достаточно длинным, а 

максимальная длина текстовых полей ограничена 256 сим-

волами. Поэтому измените тип поля Описание на Поле 

MEMO.  

3.  Щелкните на поле Дата. 

ТАБЛИЦА 3.1 . Типы данных  

4.  Для удобства прочтения даты контакта измените 4юрмат ее 

отображения, выбрав в раскрывающемся списке Формат 

поля (Format) пункт Длинный формат даты (Long Date), как 

показано на рис. 3.14.  

 Кроме типа данных и формата отображения вкладка Общие 

(General) окна конструктора позволяет настроить некоторые до-

полнительные параметры поля, влияющие на способ ввода данных. 

Параметр Значение по умолчанию (Default Value) задает содержи-

мое поля, которое записывается в новую запись в том случае, если 

Название типа  Назначение  

Текстовый (Text)  Текст длиной до 255 символов  

Поле MEMO (Memo)  Текст длиной до 65 000 символов  

Числовой (Number)  Числа различных форматов  

Дата/время 

(Date/Time)  
Дата и/или время  

Денежный 

(Currency)  
Денежные значения различных форматов  

Счетчик 

(AutoNumber)  

Счетчик, который автоматически увеличи-

вается на единицу с добавлением каждой 

новой записи  

Логический (Yes/No)  
Величины, способные принимать только 

два значения: да/нет или 1/0  

Поле объекта OLE 

(OLE Object)  

Поля, позволяющие вставлять рисунки, зву-

ки и данные других типов  

Гиперссылка 

(Hyperlink)  

Ссылки, дающие возможность открывать 

объект Access (таблицу, форму, запрос и т. 

п.), файл другого приложения или web-

страницу  
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пользователь не ввел в это поле никаких данных. Если вы регуляр-

но обновляете список контактов, то дата контакта чаще всего будет 

совпадать с текущей датой. Чтобы упростить ввод информации, 

можно задать текущую дату в качестве значения по умолчанию для 

поля Дата.  

 

 
Рис. 3.14. Выбор формата  

 

5.  Введите в поле Значение по умолчанию (Default Value) 

функцию Date(), которая возвращает текущую дату. В неко-

торых случаях требуется не только задать тип данных поля, 

но и ограничить его возможные значения некоторым ин-

тервалом или более сложным правилом отбора. Такое пра-

вило вводится в поле Условие на значение (Validation Rule). 

Предположим, вы точно знаете, что все контакты, которые 

будут заноситься в список, состоятся после 1 января 1999 г. 

Чтобы избежать ошибок, можно заставить Access сообщать 

вам о вводе неверной даты. Для этого выполните следую-

щие шаги.  

6. В поле Условие на значение щелкните на кнопке построи-

теля выражений. Откроется окно диалога. Для задания 

условий или значений определенных параметров Access 
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предлагает большой набор математических операций и 

функций. Построитель выражений помогает ориентиро-

ваться во всем многообразии функций Access. Верхнее про-

кручивающееся поле построителя содержит конструируе-

мое выражение. Его можно изменять как путем непосред-

ственного редактирования текста, так и с помощью других 

кнопок и списков построителя.  

7. Необходимо, чтобы дата записи была позднее, то есть 

больше, даты 1 января 1999 г. Поэтому щелкните на кнопке 

>, чтобы добавить нужное условие.  

 Теперь нужно указать дату, с которой выполняется сравне-

ние. Дяя этого следует воспользоваться специальной функцией, 

преобразующей строковую константу в дату в формате Access.  

8.  Дважды щелкните на папке Функции (Functions) в левом 

списке построителя выражений.  

9.  Щелкните на папке Встроенные функции (Built-in 

Function), чтобы вывести список стандартных функций 

Access.  

10.  В среднем списке выберите категорию Дата/время.  

11.  Двойным щелчком на имени функции DateValue добавьте 

ее в поле выражения. Вместо местозаполнителя аргумента 

«stringexpr» нужно ввести конкретную дату в строковом 

формате.  

12.  В поле выражения щелчком выделите текст «stringexpr», а 

затем напечатайте "1.1.99".  

13.  Щелкните на кнопке ОК.  

14. В поле Сообщение об ошибке (Validation Text) введите 

текст Неверная дата, который будет появляться при вводе 

даты, более ранней, чем 1 января 1999 г. Окончательный 

набор параметров поля Дата показан на рис. 3.15.  

15.  Щелкните на кнопке закрытия окна конструктора. В окне 

запроса на обновление структуры таблицы щелкните на 

кнопке Да. По причине добавления условий на значения 

поля Дата Access запросит о необходимости проверки со-

держимого этого поля в уже имеющихся записях таблицы. 

Щелкните на кнопке Нет (No), чтобы не выполнять провер-

ку.  
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Рис. 3.15. Параметры поля Дата  

 

 Давайте изучим влияние настроенных параметров на пове-

дение базы данных.  

16.  Выделите таблицу Список в окне базы данных и щелкните 

на кнопке Открыть (Open). Теперь все даты отображаются в 

длинном формате, а в ячейке Дата в строке новой записи 

автоматически появляется текущая дата.  

17.  Щелкните в ячейке Дата второй строки, измените ее со-

держимое на 19.11.95 и нажмите клавишу Tab, чтобы пе-

рейти к следующему полю. Так как модифицированная дата 

предшествует 1 января 1999 г., что противоречит настроен-

ному условию, Access не позволит убрать курсор из теку-

щей ячейки и откроет окно сообщения  с текстом, введен-

ным вами в поле Сообщение об ошибке конструктора таб-

лицы на шаге 14. Такое сообщение будет появляться до тех 

пор, пока вы не скорректируете дату.  

18.  Щелкните на кнопке ОК.  

19.  Исправьте дату на 19.11.00.  

20.  Закройте таблицу Список.  
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3.7 Упражнение 7. Индекс  

 Для ускорения поиска данных о конкретном человеке в таб-

лице Контакты удобно рассортировать записи по алфавиту. Чтобы 

назначить сортировку по полю Фамилия, выполните следующие 

шаги.  

1.  В окне базы данных щелкните на значке таблицы Контак-

ты.  

2.  Щелчком на кнопке Открыть откройте таблицу в режиме 

редактирования.  

3.  В окне таблицы щелкните на заголовке Фамилия, чтобы 

выделить столбец.  

 
Рис. 3.16. Сортировка фамилий по алфавиту  

 

4.  Щелчком на кнопке Сортировка по возрастанию (Sort 

Ascending) упорядочите записи столбца фамилии таблицы 

по алфавиту (рис. 3.16).  

5.  Вставьте в таблицу еще несколько человек с фамилией 

Петров. Например, Василий Петров, Николай Петров и 

Игорь Петров. Добавляйте записи в указанном порядке.  

6.  Чтобы обновить сортировку, закройте окно таблицы Кон-

такты и вновь откройте таблицу. Записи окажутся располо-

женными так, как показано на рис. 3.17.  

Фамилии упорядочены по алфавиту, но имена людей расставлены в 

беспорядке. Если бы в таблице было несколько сотен людей с фа-

милией Петров, то поиск нужного человека существенно бы 

осложнился. Чтобы выполнить сортировку сразу по нескольким 

полям, следует воспользоваться сложным индексом. Его настройка 

выполняется посредством следующих действий.  
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Рис. 3.17. Несколько человек с одинаковыми фамилиями  

 

7.  Щелчком на кнопке Вид переключитесь в режим конструк-

тора.  

8.  Чтобы открыть окно индексов таблицы Контакты, показанное 

на рис. 3.18, щелкните на кнопке Индексы (Indexes) панели 

инструментов. В окне индексов есть список со столбцами 

названия индекса, имени поля, по которому выполняется ин-

дексация, и режима сортировки (по возрастанию или по убы-

ванию). Мастер таблиц при создании таблицы Контакты ин-

дексировал ее потрем полям: Название Компании, Фамилия, 

Код_Контакты, добавив индексы с именами соответственно: 

Название Компании, Фамилия и PrimaryKey. Последний из 

трех индексов является ключом таблицы, однозначно иденти-

фицирующим ее записи. Все имеющиеся индексы простые, то 

есть назначают сортировку только по одному полю. Чтобы за-

писи с одинаковыми фамилиями располагались по алфавиту 

имен, следует модифицировать индекс Фамилия, добавив в 
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него условие сортировки по полю Имя. Для этого выполните 

следующие шаги.  

9.  Щелкните правой кнопкой мыши на той строке, которая 

расположена ниже строки индекса Фамилия.  

10.  Выберите в контекстном меню команду Добавить строки 

(Insert Rows), чтобы вставить одну пустую строку.  

11.  В новой строке щелкните на кнопке раскрывающегося 

списка ячейки Имя поля.  

12.  Выберите пункт Имя. В столбце Порядок сортировки (Sort 

Order) автоматически появится вариант По возрастанию 

(Ascending).  

 
Рис. 3.18. Индексы  

 

 В окне настройки индексов имена полей, по которым про-

исходит упорядочивание в данном индексе, располагаются в строке 

с именем индекса и ниже ее в строках с пустой ячейкой Индекс 

(Index Name) в порядке убывания влияния поля. То есть первой 

выполняется сортировка по тому полю, которое в данном индексе 
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расположено выше. В одном индексе можно использовать до 10 

полей. Таким образом, теперь индекс Фамилия упорядочивает за-

писи по алфавиту сначала по фамилиям, а потом по именам.  

 

 
Рис. 3.19. Сортировка по двум полям  

 

13.  Закройте окно индексов.  

14.  Щелкните на кнопке Вид, чтобы переключиться в режим 

редактирования таблицы.  

15.  Ответьте Да на запрос о необходимости сохранения табли-

цы. Теперь имена оказались выстроенными по алфавиту, 

как показано на рис. 3.19. Поскольку перед этим уже была 

настроена сортировка по полю Фамилия (то есть по индек-

су Фамилия, главным полем которого является Фамилия), 

вам даже не пришлось перенастраивать сортировку. Моди-

фикация индекса автоматически привела к упорядочению 

имен.  
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3.8 Контрольное упражнение  

Access автоматически обновляет файл базы данных. Чтобы 

сохранить его исходный вариант, в Проводнике создайте копии 

файлов Контакты.mdb и Список.mdb — соответственно файлы 

Контакты_копия.mbd и Список_копия.таЬ. Закончив контрольное 

упражнение, переименуйте файлы Контакты_копия.mbd и Спи-

сок_копия.mbd обратно в Контакты.mdb и Список.mdb.  

1.  Откройте таблицу Контакты в режиме конструктора.  

2.  Измените тип данных поля Адрес на Поле MEMO.  

3.  Ограничьте длину текстового поля Имя величиной 30 сим-

волов.  

o Какой параметр определяет длину поля?  

4.  Поле Фамилия является ключевым. Запретите Access до-

бавлять в таблицу Контакты записи с пустым полем Фами-

лия.  

o  Как запретить добавление пустого поля?  

5.  Закройте конструктор и сохраните структуру таблицы.  

6. Создайте новую таблицу с именем Метод.  

7.  В конструкторе добавьте в нее поле Метод ID с типом дан-

ных Счетчик и поле Вариант с типом Текстовый. Первое из 

них сделайте ключом таблицы.  

8.  Переключитесь в режим редактирования и введите в таб-

лицу три записи, в поле Метод которых введите слова Те-

лефон, Письмо, Факс. Эта таблица будет хранить возмож-

ные способы контакта.  

9.  С помощью конструктора добавьте в таблицу Список поле 

Метод ID с числовым типом.  

10.  С помощью мастера подстановки назначьте этому полю 

подстановку, состоящую из полей МетодЮ и Вариант таб-

лицы Метод.  

o Как сделать, чтобы в список подстановки кроме 

названия метода выводился его кодовый номер?  

11.  В имеющихся записях таблицы Список введите значение в 

новое поле, выбрав его в списке подстановки.  

12. Закройте базу данных.  

o Какие операции закрывают базу данных?  
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ГЛАВА 4. MICROSOFT POWERPOINT 

 
 Microsoft PowerPoint — приложение для подготовки пре-

зентаций, слайды которых выносятся на суд общественности в виде 

распечатанных графических материалов или посредством демон-

страции электронного слайд-фильма. Создав или импортировав 

содержание доклада, вы сможете быстро украсить его рисунками, 

дополнить диаграммами и анимационными эффектами. Элементы 

навигации дают возможность генерировать интерактивные презен-

тации, управляемые самим зрителем. 

 Программа PowerPoint для многих крупных организаций 

стала стандартным средством создания презентации, поскольку она 

направляет действия пользователя момента своего запуска и вплоть 

до завершения процесса разработки презента. Этот раздел посвя-

щен описанию основных понятий и инструментов PowerPoint. Вы 

научитесь быстро строить красочные презентации и модифициро-

вать их. 

4.1 Упражнение 1. Создание презентации 

 В основе любой презентации лежит набор слайдов, на кото-

рых размещаются текст, графики, рисунки. Электронные слайды 

подобны обычным фотографическим, но издаются гораздо проще. 

Программа PowerPoint сама запрашивает всю необходимую тек-

стовую и числовую информацию, а также предоставляет множе-

ство готовых вариантов дизайна и шаблонов содержания. Сейчас 

мы воспользуемся одним из таких шаблонов. 

 Сразу после запуска PowerPoint появляется окно презента-

ции с первым титульным слайдом; справа в области задач прило-

жения видно окно Создание презентации (New Presentation), пока-

занное на рис. 4.1. Оно позволяет выбрать способ создания доку-

мента. Первый раздел Открыть презентацию (Open a Presentation) 

дает возможность открыть уже существующую презентацию. В 

разделе Создание (New) перечислены возможные варианты созда-

ния новой презентации: 

  Новая презентация (Blank Presentation) без какого-либо 

форматирования; 
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  презентация Из шаблона оформления (From Design 

Template); 

 презентация Из мастера автосодержания (From AutoContent 

Wizard) с заранее заданной структурой содержания. 

 

 
Рис. 4.1. Окно диалога PowerPoint 

 

 В этом же окне можно выбрать шаблон оформления в раз-

деле Создание с помощью шаблона (New From Template). 

 Если у вас уже есть тезисы презентации и нужно лишь раз-

местить готовый текст на слайдах и оформить его надлежащим об-

разом, выполните следующие шаги: 

1.  Щелкните на пункте Общие шаблоны (General Templates). 

2. Откроется окно диалога Шаблоны (Templates), показанное 

на рис. 4.2. На вкладке Шаблоны оформления (Design 
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Templates) вы увидите список доступных шаблонов оформ-

ления слайдов. Другие вкладки этого окна открывают до-

ступ к иным способам создания презентаций, о которых мы 

поговорим позже. Щелкните по очереди на значках каждого 

из шаблонов, чтобы в расположенном справа поле про-

смотра увидеть примеры оформления презентации. 

 
Рис. 4.2. Окно диалога Шаблоны (Templates) 

 

3. Дважды, щелкните на значке шаблона Галстук (Dads Tie). 

Шаблон будет применен к слайду в окне презентации. 

Чтобы добавить в окно создания презентации свой собственный 

шаблон, сохраните его в папке Windows\Application 

Data\Microson\Templates. Шаблон появится на вкладке Общие 

(General). Чтобы поместить его на новую вкладку, которая, напри-

мер, будет содержать все шаблоны вашей фирмы, создайте в ука-

занной папке вложенную папку и переместите туда свой шаблон. 

Роль шаблона может играть любая презентация, при сохранении 

которой был выбран тип файла Шаблон презентации (Design 

Template). 

 В поле презентации окажется титульный слайд в режиме 

структуры с примененным к нему выбранным шаблоном, а в обла-

сти задач появится окно Разметка слайда (Slide Layout) с набором 

стандартных авторазметок. Поместив указатель мыши на одном из 

образцов, вы увидите всплывающую подсказку, характеризующую 
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образец, и треугольник справа от него, скрывающий раскрываю-

щийся список с набором возможных команд. 

 

 
Рис. 4.3. Титульный слайд в обычном режиме просмотра 

 

4.  Щелкните в поле с надписью Заголовок слайда (Click to 

add title) и введите заголовок презентации. В нашем приме-

ре это будет текст План развития. 

5.  Чтобы добавить к основному названию небольшое поясне-

ние, щелкните на поле Подзаголовок слайда (Click to add 

subtitle) и введите подзаголовок Отдел информационных 
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технологий. На рис. 4.3 показан сформированный титуль-

ный слайд в окне презентации PowerPoint. 

6.  Щелкните на кнопке Сохранить (Save) панели инструмен-

тов Стандартная (Standard). Откроется окно сохранения 

презентации. 

7.  В левой части окна щелкните на значке папки Мои доку-

менты (My Documents). В поле Имя файла (File Name) вве-

дите имя План и щелкните на кнопке Сохранить. Любой 

файл PowerPoint содержит всю презентацию целиком, по-

этому вам не нужно беспокоиться о том, что при демон-

страции некоторые слайды могут пропасть. 

4.2 Упражнение 2. Обычный режим просмотра  

 PowerPoint позволяет создавать презентации с очень боль-

шим количеством слайдов. Чтобы управлять этим огромным объе-

мом ин4юрмации, программа предлагает несколько режимов про-

смотра:  

  Обычный (Normal View) — режим, появившийся в впервые 

PowerPoint 2000, — вариант просмотра, объединяющий ре-

жимы слайдов, структуры и заметок;  

  Сортировщик слайдов (Slide Sorter View) — режим, демон-

стрирующий миниатюры всех слайдов, равномерно распо-

ложенные в окне просмотра;  

  Слайды (Slide View) — режим, в котором удобно констру-

ировать и корректировать отдельные слайды;  

  Структура (Outline View) — режим, отображающий тек-

стовое содержание презентации и предназначенный для 

ввода и редактирования текста;  

  Страницы заметок (Notes Page View) — режим, предназна-

ченный для создания заметок, которые помогают докладчи-

ку ориентироваться в материале во время ведения презен-

тации.  
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Рис. 4.4. Кнопки выбора режима просмотра 

 

1.  Переключение из одного режима в другой для первых двух 

режимов, а также запуск просмотра слайдов осуществляет-

ся простым щелчком па одной из трех кнопок, расположен-

ных в левом нижнем углу окна презентации (рис. 4.4).Две 

кнопки вверху окна обычного режима позволяют переклю-

чаться между режимами слайдов и структуры. Переклю-

читься на режим страниц заметок можно из меню Вид > 

Страницы заметок (View > Notes Page).  

2.  Попробуйте по очереди щелкнуть на указанных кнопках, 

наблюдая за презентацией в одном из режимов просмотра.  

3. 3 Щелкните на средней кнопке вверху окна презентации, 

чтобы вернуться в обычный режим.  

 В обычном режиме (см. рис. 4.3), который автоматически 

включается при создании пустой презентации или презентации на 

основе шаблона дизайна, окно документа поделено на три области: 

область слайда, поле структуры и область заметок. Первая из них 

всегда содержит общий вид текущего слайда. Расположенная слева 

область структуры презентации является уменьшенной копией ре-
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жима структуры. В правой нижней части окна презентации нахо-

дится область заметок. Сюда можно ввести пояснительный текст, 

который не появляется на самом слайде, но который можно выве-

сти на экран в режиме заметок или, готовя заметки докладчика, 

распечатать рядом с соответствующим слайдом.  

4. Соотношение размеров областей обычного режима про-

смотра можно изменить. Для этого поместите указатель 

мыши на границу между областями, чтобы значок указате-

ля сменился на двунаправленную стрелку, нажмите кнопку 

мыши и перетащите линию границы. Подобрав нужный 

размер, отпустите кнопку мыши.  

 В обычном режиме, как и в большинстве других режимов 

просмотра, в окне PowerPoint присутствуют три панели инструмен-

тов. Вверху расположена панель Стандартная. Ее инструменты вы-

полняют операции открытия и сохранения презентаций, копирова-

ния и вставки содержимого, добавления слайдов и объектов. Под 

ней находится панель инструментов Форматирование (Formatting). 

Она позволяет изменять шрифт и начертание выделенного текста, 

форматировать абзацы и списки, настраивать эффекты анимации. О 

панели инструментов Рисование (Drawing), расположенной в ниж-

ней части окна, мы поговорим на следующем занятии.  

4.3 Упражнение 3. Добавление нового слайда  

 Сформировав титульный слайд, можно перейти к добавле-

нию других слайдов.  

1.  Найдите на панели инструментов Форматирование кнопку 

Создать слайд (New Slide). Если вы забыли, как выглядит 

значок этой кнопки, переместите указатель мыши на панель 

инструментов и задержите его на несколько секунд. По-

явится экранная подсказка, разъясняющая смысл той кноп-

ки, на которой расположен указатель мыши. Перемещайте 

указатель по кнопкам и читайте экранные подсказки.  

2.  Если кнопки Создать слайд не оказалось в панели инстру-

ментов Форматирование, щелкните на маленькой треуголь-

ной стрелке, расположенной на правом краю панели. От-

кроется дополнительная палитра с кнопками (рис. 4.5). 
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Здесь, можно отыскать пропавший инструмент Создать 

слайд.  

3. Щелкните на кнопке Новый слайд (New Slide). В окне пре-

зентации появится незаполненный второй слайд. 

 

 
Рис. 4.5. Дополнительная 

палитра кнопок стандарт-

ной панели инструментов 

 
Рис. 4.6. Окно Разметка слай-

да с набором авторазметок  

 

4.  В области задач в окне Разметка слайда, показанном на 

рис. 4.6, PowerPoint предлагает 27 типов стандартных авто-

разметок, которые способны удовлетворить практически 

любые потребности разработчиков презентаций.  

 Авторазметка — это шаблон слайда с заранее размещенны-

ми стандартными объектами, такими как заголовок, маркирован-

ный список, диаграмма или рисунок.  
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 После создания слайда на базе авторазметки вам остается 

лишь щелкать на место заполнителях этих объектов и вводить не-

обходимую информацию.  

5. Просмотрите имеющиеся авторазметки. Для этого восполь-

зуйтесь полосой прокрутки, расположенной в правой части 

окна.  

Примечание  
На значках авторазметок заголовки показаны серой полосой, мар-

кированные списки — прямоугольником с тремя пунктами. Диа-

граммы представлены маленькой гистограммой, рисунки — порт-

ретом человечка. Здесьже можно найти миниатюры организацион-

ных диаграмм и видеоклипов.  

6.  Выберите для второго слайда авторазметку Маркирован-

ный список (Bulleted List), щелкнув на ней.  

В области структуры презентации появится значок второго 

слайда, а справа будет виден сам новый слайд с двумя местозапол-

нителями.  

Местозаполнитель представляет собой рамку, заменяющую 

будущий объект. Внутри рамки содержится текст, предлагающий 

щелкнуть в области рамки для ввода данных. К примеру, автораз-

метка Маркированный список содержит два место-заполнителя 

один для заголовка и второй для маркированного списка (рис. 4.7).  

7. Чтобы добавить заголовок нового слайда, щелкните на ме-

стозаполнителе Заголовок слайда (Click to add title). Текст 

местозаподнителя исчезнет, и вы сможете сразу ввести за-

головок. Напечатайте слова Направления развития.  

8.  Щелкните на местозаполнителе маркированного списка 

Текст слайда (Click to add text) и введите первый пункт 

списка Спутниковая связь. Нажмите клавишу Enter.  

9.  В списке появится маркер второго пункта. Не огорчайтесь, 

если форма маркера вас не устраивает. Позже его можно 

будет изменить или даже совсем убрать. Введите текст 

Цифровая телефония. Снова нажмите клавишу Enter и вве-

дите слово Интернет.  
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Рис. 4.7. Слайд с маркированным списком 

 

4.4 Упражнение 4. Заметки докладчика  

 Второй слайд презентации практически готов. Осталось до-

бавить заметки, которые помогут докладчику не растеряться в мо-

мент представления планов отделана суд начальства. Каждый 

слайд презентации имеет особый вид внешнего представления, 

называемый заметками докладчика. На странице заметок всегда 

присутствуют два объекта: сам слайд в верхней части страницы и 

заметки в ее нижней части. Эти заметки не видны на экране в ре-

жиме просмотра презентации, они не выводятся на печать вместе 

со слайдом. Однако, проводя электронную презентацию в локаль-
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ной сети, докладчик может читать заметки на экране своего ком-

пьютера. Кроме того, страницы заметок можно распечатать и поль-

зоваться ими во время доклада.  

Чтобы добавить текст заметок, выполните следующие шаги.  

1.  В правой нижней области окна презентации найдите ме-

стозаполнитель Заметки к слайду (Click to add notes) и 

щелкните на нем. Введите текст Сделать акцент на приме-

нении цифровых технологий связи.  

2.  Чтобы увидеть страницу заметок целиком, выберите ко-

манду Вид > Страницы заметок. Включится режим страниц 

заметок (рис. 4.8).  

 

 
Рис. 4.8. Слайд в режиме просмотра страниц заметок 
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3.  Выбрав команду Вид > Обычный (View > Normal), верни-

тесь в обычный режим просмотра.  

Обратите внимание, что новый слайд появляется не только в обла-

сти слайдов. Он представлен и в области структуры презентации. 

Здесь можно отыскать значок слайда под номером 2, заголовок 

слайда и все три пункта маркированного списка (рис. 4.9).  

 
Рис. 4.9. Второй слайд презентации в обычном режиме просмотра 

 

4.  Щелчком на кнопке Сохранить панели инструментов 

Стандартная сохраните текущий вариант презентации.  

5.  Щелкните на кнопке с косым крестом в правом верхнем 

углу окна презентации, чтобы закрыть документ.  
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4.5 Упражнение 5. Режим слайдов  

 В режиме слайдов отдельный слайд занимает все окно пре-

зентации. Это как бы увеличенный вариант области слайда обыч-

ного режима просмотра. В режиме слайдов удобно редактировать 

отдельные объекты, добавлять рисунки и текстовые комментарии. 

Давайте продолжим построение презентации, созданной в преды-

дущих упражнениях.  

1.  Щелкните на кнопке Открыть (Open) панели инструментов 

Стандартная.  

2. В окне диалога открытия файла щелкните на папке Мои до-

кументы, найдите значок документа План.ррt и дважды 

щелкните на нем.  

3.  Щелчком на кнопке панели смены режимов включите ре-

жим слайдов.  

 На экране появится первый слайд презентации. Новые 

слайды в PowerPoint всегда вставляются после текущего. Мы хотим 

добавить третий слайд, поэтому нужно сделать текущим второй 

слайд презентации.  

4.  Щелкните на кнопке Следующий слайд (Next Slide) полосы 

прокрутки слайдов. На экране появится второй слайд (рис. 

4.10).  

5. Щелкните на кнопке Создать слайд панели инструментов 

Форматирование.  

6.  В окне Разметка слайда щелкните на авторазметке Марки-

рованный список.  

7.  Введите заголовок слайда Выставки и конференции. 

Щелкните на место заполнителе маркированного списка и 

введите пункты:  

 Вам пришло в голову, что хорошо бы разделить названия 

выставок и конференций и разместить их в отдельных списках. Но 

дополнительный слайд кажется вам лишним, а на текущем слайде 

все место занято имеющимся списком. Что делать?  

 PowerPoint позволяет оперативно изменять разметку любо-

го слайда. Если вы решили добавить на слайд еще один список или 

дополнительный рисунок, бывает достаточно просто сменить авто-
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разметку, хотя иногда приходится добавлять недостающие объекты 

вручную.  

 
Рис. 4.10. Второй слайд в режиме просмотра слайдов 

8. В окне Разметка слайда щелкните на авторазметке Текст в 

две колонки (2 Column Text).  

9.  Введите в появившийся справа дополнительный маркиро-

ванный список следующие пункты:  

  История телефонной связи;  

  Опыт зарубежных филиалов;  

  Исследования отечественного рынка.  

10.  Выберите в меню Вставка (Insert) команду Надпись (Text 

Box).  

11.  Ниже маркированных списков растяните мытью рамку 

текстового поля. Введите текст Сроки проведения: с мая по 

ноябрь.  
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Рис. 4.11. Изменение разметки второго слайда 

 

12.  Чтобы отцентрировать текст, щелкните в панели инстру-

ментов Форматирование на кнопке По центру (Center). 

Окончательный вид третьего слайда показан на рис. 4.12.  

Для перехода от слайда к слайду в режиме слайдов пользуйтесь 

вертикальной полосой прокрутки. Если выбранный масштаб не 

позволяет увидеть весь слайд целиком, кнопки и ползунок полосы 

прокрутки обеспечивают возможность перемещений как по слайду, 

так и между слайдами вперед и назад в пределах всей последова-

тельности слайдов данной презентации. При перетаскивании мы-

шью ползунка полосы прокрутки рядом с ним появляется номер и 

заголовок текущего; слайда. Для быстрого перехода к предыдуще-

му и-последующему слайдам пользуйтесь кнопками Следующий 

слайд и Предыдущий слайд (Previous Slide) или клавишами Page 

Down и Page Up.  
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Рис. 4.12. Третий слайд презентации 

 

Примечание  
Этими же приемами перехода по слайдам можно пользоваться и во 

всех остальных режимах просмотра, однако режим структуры и 

обычный режим предлагают другие, более удобные способы пере-

ключения слайдов.  

 

Режим структуры  
Режим структуры похож на обычный, но область структуры 

презентации увеличена, а области слайда и заметок уменьшены. 

Этот режим в основном предназначен для работы над текстом. Он 

позволяет сконцентрироваться на словесном изложении идей, по-

добрать оптимальную последовательность подачи материала. Ди-

зайн и другие элементы оформления, как правило, прорабатывают-

ся в других режимах просмотра, хотя область слайда позволяет ра-

ботать с конкретными объектами и в режиме структуры.  
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4.6 Упражнение 6. Содержание презентации  

 На рис. 4.13 представлены разделы и подразделы презента-

ции в режиме структуры. В расположенной слева области структу-

ры есть пронумерованные значки слайдов с заголовками, а также 

подзаголовки и пункты списков. Подобная область структуры име-

ется и в обычном режиме просмотра, который поддерживает все 

приемы работы со структурой презентации. Однако при обычном 

просмотре презентации размер этой области, как правило, невелик.  

 Для разработки содержания презентации предназначена 

специальная панель инструментов Структура (Outlining), показан-

ная на рис. 4.14. Она помогает перемещать слайды презентации, 

изменять уровень структурных элементов, сворачивать и развора-

чивать вложенные списки пунктов.  

 
Рис. 4.13. Режим структуры 
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Примечание  
В области структуры отображается не всякий текст, имеющийся на 

слайде, а толь ко тот, который был введен в специальные зоны раз-

метки слайдов— текстовые местозаполнители. Обратите внимание, 

что в структуре третьего слайда отсутствует надпись, добавленная 

вами в нижнюю часть слайда.  

 

 
Рис. 4.14. Панель инструментов структуры 

 

Примечание  
Если панель Структура отсутствует на экране, щелкните правой 

кнопкой мыши на любой панели инструментов и выберите в кон-

текстном меню пункт Структура (Outlining). Повторный выбор того 

же пункта скроет указанную панель инструментов.  
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  Давайте воспользуемся режимом структуры и дополним презен-

тацию еще несколькими слайдами, а заодно научимся перемещать 

слайды и пункты списков в пределах одной презентации. .  

1.  Чтобы переключиться в режим структуры, щелкните на со-

ответствующей кнопке панели режимов.  

2.  Щелкните на кнопке Свернуть все (Collapse All) панели 

инструментов Структура, чтобы в структуре презентации 

остались видны только заголовки слайдов.  

3.  Переместите текстовый курсор в конец заголовка третьего 

слайда и нажмите клавишу Enter. В презентацию будет до-

бавлен четвертый слайд.  

4.  Введите текст Структура подразделения и нажмите клави-

шу Enter. Появится пятый слайд.  

5.  Повторяя указанные действия, введите заголовки пятого и 

шестого слайдов, чтобы структура презентации стала такой, 

как показано на рис. 4.15.  

 
Рис. 4.15. Список слайдов презентации 
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 Шестой слайд будет содержать двухуровневый маркиро-

ванный список. Давайте введем его пункты.  

6.  Нажмите клавишу Enter. Появится седьмой слайд. Щелк-

ните на кнопке Понизить уровень (Demote) панели инстру-

ментов Структура. Строка седьмого слайда превратится в 

пункт списка. Введите текст Телевидение.  

7.  Нажмите клавишу Enter. Снова щелкните на кнопке Пони-

зить уровень. Появится пункт списка второго уровня вло-

жения. Введите текст 30-секундный ролик. Нажмите кла-

вишу Enter и введите текст 60-секундный ролик.  

8.  Еще раз нажмите клавишу Enter и щелкните на кнопке По-

высить уровень (Promote). Пункт списка второго уровня 

превратится в пункт списка первого уровня. Введите слово 

Радио.  

9.  Нажмите клавишу Enter и щелкните на кнопке Понизить 

уровень.  

 
Рис. 4.16. Двухуровневый маркированный список 
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10. Введите еще несколько пунктов списка, как показано на 

рис. 4.16.  

 При необходимости разметку слайда можно изменить пря-

мо в режиме структуры. Кроме того, хотелось бы переставить ме-

стами слайды презентации и поменять пункты списка шестого 

слайда. Чтобы скорректировать структуру презентации, выполните 

следующие действия.  

11.  Выделите пятый слайд. Он сделан по разметке Заголовок и 

текст. Щелкните на авторазметке Заголовок и текст в две 

колонки в окне Разметка слайда в области задач приложе-

ния. В пятом слайде появятся два местозаполнителя для 

ввода текста.  

Примечание  
Для повышения и понижения уровня элемента структуры можно 

пользоваться соответствующими кнопками панели Форматирова-

ние, клавишей Tab и комбинацией клавиш Shift+Tab.  

12.  Поместите указатель мыши на значок шестого слайда.  

13. Нажмите левую кнопку мыши и тащите указатель вверх. 

Когда горизонтальная линия, показывающая будущее по-

ложение шестого слайда, окажется между значками четвер-

того и пятого слайдов, отпустите кнопку мыши (рис. 4.17). 

Пятый и шестой слайды поменяются местами.  

14. Щелкните на маркере пункта Телевидение. Окажутся выде-

ленными как этот пункт, так и все вложенные подпункты.  

15. Тремя щелчками на кнопке Вниз (Move Down) панели ин-

струментов Структура переместите выделенные пункты в 

конец слайда.  

16. Щелчком поместите текстовый курсор в заголовок слайда 3 

и щелкните на кнопке Развернуть (Expand) панели инстру-

ментов Структура. На экране появится содержимое третье-

го слайда. Изучите различия между структурой списков 

разных слайдов.  

Чтобы свернуть содержимое слайда, с которым вы не работаете в 

данный момент, поместите курсор в тело этого слайда и щелкните 

па кнопке Свернуть (Collapse).  

17.  Щелкните на кнопке Развернуть все (Expand All) панели 

инструментов Структура, чтобы вывести на экран текст 

всех слайдов.  
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Рис. 4.17. Перемещение слайда с помощью мыши 

 

Примечание  
Если панель инструментов Структура отсутствует на экране, для 

разво-рачивания и сворачивания структуры слайдов пользуйтесь 

кнопкой Развернуть панели инструментов Стандартная, которая 

работает как флажок.  

18.  Щелкните на кнопке Отобразить форматирование (Show 

Formatting) панели инструментов Структура или Стандарт-

ная. Вы увидите реальный шрифт и маркеры всех пунктов 

структуры слайдов, как показано на рис. 4.18. В этом режи-

ме удобно изменять начертание текста прямо в структуре 

презентации и сравнивать шрифты различных слайдов.  
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Рис. 4.18. Структура слайдов в режиме показа форматирования 

 

19. Чтобы вернуться к редактированию структуры и не отвле-

каться на форматирование текста, повторно щелкните на 

кнопке Отобразить форматирование. Элементы форматиро-

вания текста исчезнут.  

4.7 Упражнение 7. Итоговый слайд  

 PowerPoint предоставляет возможность простого и опера-

тивного создания итогового слайда на основе последовательности 

выбранных слайдов. В итоговом слайде формируется маркирован-

ный список заголовков каждого слайда серии. Итоговый слайд 

можно поместить как до, так и после обобщаемой им совокупно-

сти. Он может играть роль аннотации доклада.  
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Чтобы создать итоговый слайд, выполните следующие действия.  

1.  Нажатием клавиш Alt+Shift+A сверните содержимое всех 

слайдов.  

2.  Щелкните на значке слайда 2, нажмите клавишу Shift и, не 

отпуская ее, щелкните на значке слайда 6.  

3.  Щелкните на кнопке Итоговый слайд (Summary Slide) па-

целн инструментов Структура. Итоговый слайд появится 

перед выделенным набором, то есть он станет вторым 

слайдом презентации.  

4. Выделите слова Итоговый слайд (Summary Slide), протащив 

по ним указатель мыши, и введите в качестве заголовка 

итогового слайда текст Содержание доклада.  

На рис. 4.19 показан итоговый слайд в обычном режиме просмотра.  

 
Рис. 4.19. Итоговый слайд 
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4.8 Упражнение 8. Мастер автосодержания  

 Конечно, PowerPoint не знает, что именно вы хотите ска-

зать, но разработчикам программы хорошо известно, каким обра-

зом умелые докладчики строят свои презентации. Мастер автосо-

держания предлагает достаточное количество хорошо отработан-

ных макетов презентаций, среди которых можно найти варианты, 

раскрывающие следующие темы:  

 доклады по общим вопросам;  

 доклады по служебным вопросам;  

  описания проектов;  

 отчеты о продажах и маркетинге;  

  сообщения в стиле Карнеги.  

Чтобы создать базовую структуру презентации, выполните следу-

ющие шаги.  

1. Выберите команду Файл > Создать (File > New). В области 

задач приложения в окне Создание презентации щелкните 

на пункте из мастера автосодержания.  

2.  В первом, вступительном окне мастера автосодержания 

щелкните на кнопке Далее (Next).  

3.  В окне Вид презентации (Presentation Type) щелкните на 

кнопке нужной категории или на кнопке Все (All), чтобы 

увидеть все предлагаемые шаблоны (рис. 4.20).  

 

 
Рис. 4.20. Выбор типа презентации 
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4. Подыщите в списке шаблонов презентацию подходящего 

типа. Для примера давайте выберем пункт План продаж 

(Marketing Plan).  

5. Затем щелкните на кнопке Далее.  

6.  В следующем окне мастера выберите стиль презентации. 

Здесь предлагается пять вариантов:  

 Презентация на экране (On-screen presentation);  

  Презентация в Интернете (Web-presentation);  

  Черно-белые прозрачки (Black and white overheads);  

  Цветные прозрачки (Color overheads);  

  Слайды 35 мм (35mm slides).  

Выберите положение переключателя Презентация на экране и 

щелкните на кнопке Далее.  

7.  В появившемся окне параметров презентации в поле Заго-

ловок презентации (Presentation Title) введите заголовок.  

8.  В поле Нижний колонтитул (Footer) введите текст Предло-

жения на следующий год, который будет появляться в ниж-

нем колонтитуле каждого слайда.  

9. Оставьте установленными флажки Дата последнего обновле-

ния (Data Last Update) и Номер слайда (Slide Number), которые 

инициируют добавление даты создания презентации и номера 

слайда на все слайды последовательности (рис. 4.21).  

10.  Щелкните на кнопке Далее.  

 

 
Рис. 4.21. Дополнительные параметры презентации 
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11.  В последнем окне мастера автосодержания щелкните на 

кнопке Готово (Finish). В результате появится новая пре-

зентация, структура которой показана на рис. 4.22. Обрати-

те внимание, что слайды созданной презентации снабжены 

не только заголовками, но и предполагаемым текстовым 

содержанием.  

 
Рис. 4.22. Структура презентации, созданная 

Мастером автосодержания 

 

12.  Сохраните полученную презентацию в файле План про-

даж.ppt. Она пригодится в следующих упражнениях.  

 На основе базовой структуры, сформированной мастером 

автосодержания, легко построить свой собственный доклад. Для 

этого нужно лишь подправить заголовки и наполнить пункты пре-

зентации конкретными фактами. При желании можно сменить 

оформление и добавить необходимые диаграммы и рисунки. Как 

это делается, вы узнаете из следующих упражнений.  
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4.9 Упражнение 10. Перестановка и копирование слайдов  

Перемещать слайды последовательности можно с помощью мыши, 

команд меню или кнопок панели инструментов. Чтобы изменить 

расположение слайдов презентации План.ррt методом «перетащить 

и оставить», выполните следующие действия.  

1.  Щелчком на кнопке панели режимов включите сортиров-

щик слайдов (рис. 4.23). При переключении в режим сорти-

ровщика панель инструментов Форматирование заменяется 

на панель Сортировщик слайдов (Slide Sorter).  

 
Рис. 4.23. Режим сортировщика слайдов 

 

2.  Поместите указатель мыши на второй слайд, который мы 

будем перемещать.  
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3.  Нажмите кнопку мыши и перетащите вертикальную линию 

позиции вставки в новое положение между четвертым и пя-

тым слайдами.  

4.  Отпустите кнопку мыши. Слайд передвинется на новое ме-

сто.  

 Чтобы переместить или скопировать группу слайдов, сна-

чала их нужно выделить. Для этого воспользуйтесь следующими 

приемами.  

Примечание  
Чтобы вместо перемещения слайда или группы слайдов выполнить 

их копирование, в процессе перетаскивания удерживайте нажатой 

клавишу Ctrl. Слайды появятся в новой позиции, а их копия сохра-

нится на прежнем месте.  

5. Для выделения нескольких смежных слайдов (например, 5, 

6 и 7) поместите указатель рядом с первым слайдом после-

довательности (слайд 5).  

6.  Нажмите кнопку мыши и протащите указатель через этот 

слайд до последнего слайда последовательности (слайд 7), 

как показано на рис. 4.24.  

 

 
Рис. 4.24. Перемещение группы слайдов 

 

 Вместо этого можно щелкнуть на пятом слайде, нажать 

клавишу Shift и, не отпуская ее, щелкнуть на седьмом слайде.  

7. Чтобы добавить в выделенную группу несмежный слайд 3, 

нажмите клавишу Ctrl и щелкните на третьем слайде.  

8. Щелчком на кнопке Копировать (Copy) панели инструмен-

тов Стандартная скопируйте группу слайдов.  

9.  Чтобы поместить точку вставки между первым и вторым 

слайдами, щелкните на первом слайде.  

10.  Щелчком на кнопке Вставить (Paste) панели инструментов 

Стандартная вставьте скопированные слайды между пер-

вым и вторым слайдами презентации.  
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4.10 Упражнение 11. Добавление и удаление слайдов  

 Кроме перестановки слайдов в процессе разработки презен-

тации может понадобиться добавить новые или убрать некоторые 

слайды. Это удобно делать в режиме сортировщика, так как здесь 

можно наблюдать влияние выполненных изменений на общий вид 

презентации.  

1.  Щелчками на нижней кнопке полосы прокрутки переме-

ститесь в конец презентации.  

2.  Выделите слайд 7, а затем щелчком на кнопке Вырезать 

(Cut) панели инструментов Стандартная удалите его.  

3.  Щелкните на слайде 3, нажмите клавишу Shift и щелкните 

на слайде 5. Нажатием клавиши Delete удалите выделенные 

слайды 3,4 и 5. Оставшиеся слайды будут перенумерованы.  

4.  Щелкните на слайде 5, а затем на кнопке Новый слайд па-

нели инструментов Стандартная.  

5.  В окне разметки слайда щелкните на авторазметке Текст и 

графика (Text & Clip Art). Между пятым и шестым слайда-

ми появится новый, пустой слайд, который можно напол-

нить содержанием в обычном режиме, режиме слайдов или 

структуры.  

Примечание  
Чтобы выйти из режима сортировщика и вернуться к обычному 

просмотру конкретного слайда, просто дважды щелкните на этом 

слайде.  

 

4.11 Упражнение 12. Перемещение слайдов 

между презентациями  

 Слайды можно перемещать и копировать не только в пре-

делах одной презентации, но и между различными презентациями. 

Для этого необходимо расположить презентации рядом друг с дру-

гом в режиме сортировщика слайдов. Выполните следующие дей-

ствия.  

1.  Откройте презентацию План.ррt.  

2. Откройте презентацию План продаж.ppt.  
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Рис. 4.25. Окна двух презентаций в режиме сортировщика 

 

3.  Выберите команду Упорядочить все (Arrange All) меню 

Окно (Window), чтобы окна обеих презентаций размести-

лись рядом друг с другом.  

4. Переключите обе презентации в режим сортировщика (рис. 

4.25). Для этого щелкните на соответствующих кнопках па-

нелей режимов.  

 Теперь можно перемещать и копировать слайды между пре-

зентациями точно так же, как это делалось в пределах одной пре-

зентации. При этом шаблон слайда автоматически меняется в соот-

ветствии с шаблоном презентации, в которую он перемещается.  
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4.12 Упражнение 13. Шаблон дизайна и цветовая схема  

 Самый простой и наиболее всеобъемлющий способ измене-

ния внешнего вида презентации — это применение другого шабло-

на. Смена шаблона влечет модификацию цветовой схемы, от кото-

рой зависят цвета элементов презентации, влияет на дизайн фона и 

принимаемые по умолчанию параметры форматирования текста. 

Поставляемые в комплекте PowerPoint шаблоны дизайна разрабо-

таны профессиональными художниками и гарантируют элегант-

ность и привлекательность презентации.  

 Для изменения шаблона существующей презентации вы-

полните следующие действия.  

1.  Откройте презентацию План продаж.ppt.  

2.  Выберите команду Формат > Оформление слайда (Format > 

Slide Design).  

3.  В области задач приложения появится окно Дизайн слайда 

(Slide Design) с тремя параметрами. Щелкните на пункте 

Шаблоны оформления (Design Templates). В окне Приме-

нить шаблон оформления (Apply a design template) будут 

отображаться различные шаблоны; щелкайте поочередно на 

них, чтобы увидеть предлагаемое оформление в окне пре-

зентации.  

4.  Остановитесь на понравившемся вам варианте.  

 Одним из компонентов каждого шаблона является цветовая 

схема, которая определяет упорядоченную последовательность из 

восьми цветов, предназначенных для изображения различных элемен-

тов оформления презентации. Простой смены некоторых цветов или 

всей цветовой схемы бывает достаточно, чтобы презентация полно-

стью преобразилась. Чтобы скорректировать цветовую схему презен-

тации, проще всего выбрать одну из стандартных схем PowerPoint.  

5. Переключитесь в режим сортировщика.  

6. Любым из вышеописанных способов выделите четвертый и 

пятый слайды или любые другие слайды, которым нужно 

назначить новую цветовую схему.  

7.  Щелкните на пункте 11ветовые схемы (Color Schemes) в 

окне Дизайн слайда. В окне Применить цветовую схему 

(Apply a color scheme) будут отображаться стандартные 

цветовые схемы PowerPoint, как показано на рис. 4.27.  
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Рис. 4.26. Выбор шаблона дизайна 

 

 
Рис. 4.27. Смена цветовой схемы слайдов 

 

8. Поставьте указатель мыши на одну из них. Справа появля-

ется маленький треугольник, щелчок на котором выводит 
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на экран раскрывающееся меню. Щелкните на пункте При-

менить к выделенным слайдам (Apply to Selected Slides), и в 

окне презентации наблюдайте воздействие ее на оформле-

ние выделенных слайдов.  

9. Поочередно просмотрите различные схемы и выберите 

подходящую. Если новая схема оказалась хороша и вы ре-

шили перекрасить все слайды презентации, в раскрываю-

щемся списке соответствующей схемы щелкните на пункте 

Применить ко всем слайдам (Apply to All Slides).  

 

4.13 Контрольное упражнение  

 Выполнитt следующие операции и ответить па поставлен-

ные вопросы.  

1.  Создайте пустую презентацию без какого-либо оформле-

ния и содержания.  

2.  Добавьте несколько слайдов в режиме структуры.  

3. Переключитесь в режим слайдов.  

4.  Удалите второй слайд.  

o  Как удалить слайд в режиме слайдов?  

5.  Переключитесь в окно презентации План.ррt  

6. На слайде Выставки и конференции презентации План.ррt 

есть два маркированных списка. Превратите второй из них 

в отдельный слайд с соответствующим заголовком.  

o Как превратить маркированный список в отдельный 

слайд?  

7. Переместите группу слайдов с четвертого но шестой между 

первым и вторым слайдами.  

8.  Переключитесь в режим сортировщика и создайте итого-

вый слайд для группы слайдов со второго по шестой.  

o Как создать итоговый слайд в режиме сортировщи-

ка?  

 Закройте все окна презентаций. 
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ГЛАВА 5. MICROSOFT FRONTPAGE  

 
 Microsoft Frontpage — современная интегрированная обо-

лочка для построения отдельных web-страниц и целых web-узлов. 

Даже неопытный пользователь, незнакомый с языками программи-

рования, сможет с помощью Frontpage самостоятельно создать свой 

собственный web-узел и опубликовать его в Интернете. Web-

редактор Frontpage станет прекрасным дополнением и для арсенала 

опытного Web-дизайнера.  

 Web-узел — это набор файлов в формате HTML, располо-

женных в определенной папке и связанных друг с другом гиперс-

сылками. Один из файлов web-узла назначается главным, он пред-

ставляет собой домашнюю страницу и открывается в браузере 

пользователя при подключении к web-узлу. Остальные web-

страницы выводятся в окно браузера по мере перехода к ним по 

гиперссылкам. Кроме файлов HTML в состав узла входит набор 

графических объектов формата GIF или JPG, предназначенных для 

оформления страниц. С развитием браузеров, предлагающих самые 

разнообразные расширения стандарта HTML, в web-узлах все чаще 

стали появляться файлы других форматов.  

5.1 Упражнение 1. Мастер web-узла  

 Чтобы создать законченный web-узел, недостаточно просто 

разместить в одной папке несколько HTML-файлов. Грамотно по-

строенный узел имеет хорошо продуманную структуру. Это облег-

чает пользователю поиск необходимой информации. Если у вас нет 

большого опыта работы с web-страницами, мастер web-узла помо-

жет правильно скомпоновать узел, а вам останется только напол-

нить страницы содержанием. Чтобы прибегнуть к услугам мастера, 

выполните следующие шаги.  

1. Запустите Frontpage.  

2. Выберите команду Файл > Создать ^ Страница или web-

узел (File > New > Web). В области задач приложения от-

кроется окно Создание web-страниц (New Page or Web) со 

списком шаблонов и мастеров, которыми можно восполь-

зоваться для построения web-узла (рис. 5.1).  
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3. В разделе Создание с помощью шаблона (New from 

Template) щелкните на значке Шаблоны веб-узлов (Web 

Site Template) и в появившемся окне диалога Шаблоны веб-

узлов (Web Site Templates) щелкните на значке Мастер кор-

поративного веб-узла (Corporate Presence Wizard).  

4.  В поле раздела Options (Параметры) введите название пап-

ки, в которой будут храниться файлы узла (я буду пользо-

ваться для этих целей папкой С: \Мои документы\Му 

Webs\Corporate).  

 

 
Рис. 5.1. Мастера и шаблоны web-узлов  

 

5. Щелкните на кнопке ОК.  

6.  В первом окне мастера щелкните на кнопке Далее (Next).  

Второе окно предлагает список основных web-

страниц, которые можно включить в новый web-

узел:  

o Домашняя страница (Home Page);  

o  Что нового (What's New);  

o  Товары и услуги (Products/Services);  

o  Оглавление (Table of Contents);  
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o  Обратная связь (FeedBack form);  

o Форма поиска (Search form).  

7.  Оставьте установленными все флажки и щелкните на 

кнопке Далее. Следующее окно мастера, показанное на рис. 

5.2, предлагает определить вид домашней страницы. Уста-

навливая и сбрасывая флажки этого окна, вы добавляете 

или убираете соответствующие разделы домашней страни-

цы.  

8. Установите все четыре флажка.  

9.  Щелкните на кнопке Далее.  

Шесть следующих окон диалога мастера настраивают вид страни-

цы определенного типа (из тех, которые были выбраны во втором 

окне мастера). Последовательно изучите каждое окно и установите 

флажки для тех компонентов, которые необходимо включить в 

web-узел. В последующих упражнениях этого занятия предполага-

ется, что в этих шести окнах были оставлены те варианты настрой-

ки, которые предлагаются мастером по умолчанию.  

 

 
Рис. 5.2. Мастер корпоративного узла  

 

10. Десятое окно мастера задает общее оформление всех стра-

ниц. Установите флажки этого окна в соответствии с рис. 

5.3, затем щелкните два раза на кнопке Далее.  
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Рис. 5.3. Настройка оформления страниц  

 

11.  Введите полное название компании, то же самое название, 

сокращенное до одного слова, и адрес компании. Щелкните 

на кнопке Далее.  

12.  В следующем окне введите телефон компании, номер фак-

са, электронный адрес web-мастера и адрес информацион-

ной поддержки. Щелкните два раза на кнопке Далее, а за-

тем на кнопке Готово (Finish). Мастер сгенерирует новый 

web-узел и откроет его в режиме просмотра задач со спис-

ком действий, которые необходимо выполнить для получе-

ния законченного узла. Пункты этого списка, показанные 

на рис. 5.4, были добавлены мастером. В них перечислены 

операции, с помощью которых вы должны наполнить 

смысловым содержанием сформированные web-страницы. 

В процессе разработки узла можно вручную добавлять но-

вые задачи, связанные с той или иной web-страницей. Вы 

научитесь этому в следующем упражнении. Список задач 

всегда под рукой, он хранится вместе с файлами web-узла и 

не даст позабыть о незавершенных операциях. Чтобы от-

крыть его, достаточно щелкнуть на кнопке Задачи (Tasks) 

панели режимов.  
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Рис. 5.4. Просмотр задач  

 

Примечание  
Чтобы добавить задачу, выберите команду файл > Создать > Задача 

(File > New > Task). Для изменения параметров конкретной задачи 

дважды щелкните на ее строке.  

5.2 Упражнение 2. Режимы просмотра  

 Frontpage предлагает шесть режимов просмотра web-узла, 

кнопки которых имеются на панели режимов:  

 Страница (Page) — редактор отдельной web-страницы. В 

этом режиме можно изменять содержание любой страницы 
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узла, настраивать ее оформление и просматривать HTML-

код, на основе которого генерируется страница;  

 Папки (Folders) — список папок и файлов web-узла с их по-

дробными характеристиками, подобный списку окна Про-

водника Windows;  

  Отчеты (Reports) — статистическая информация об узле и 

отдельных его компонентах;  

 Переходы (Navigation) — редактор структуры web-узла, 

позволяющий в графическом режиме изменять связи и пе-

рестраивать гиперссылки;  

 Гиперссылки (Hyperlinks) — список web-страниц узла и 

схема гиперссылок выделенной страницы;  

 Задачи (Tasks) — список задач, связанных с определенны-

ми файлами, которые нужно не забыть выполнить для за-

вершения разработки узла.  

 Переключать режимы просмотра можно как с помощью ко-

манд меню Вид (View), так и посредством кнопок панели режимов, 

расположенной в левой части окна Frontpage.  

1. Чтобы просмотреть список файлов, сгенерированных ма-

стером web-узла, щелкните на кнопке Папки (Folders) пане-

ли режимов. Окно Frontpage разделится на две области 

(рис. 5.5). В левую будет выведен список папок, вложенных 

в папку С:\Мот документы\Согрога1е (в которой хранятся 

все файлы текущего web-узла), а в правую — значки фай-

лов корневой папки узла.  

Примечание  
Режим просмотра Папки (Folders)-Ha самом деле отображает не все 

файлы web-узла, а только те, которые несут определенную смысло-

вую нагрузку. Вспомогательные папки, содержащие графические 

файлы стандартных элементов оформления и файлы поддержки 

расширений Frontpage, остаются скрытыми.  

2.  Чтобы просмотреть список изображении, используемых в 

web-узле, щелк-к ните на значке папки images.  

3. Дважды щелкните на файле smallnsw.gif. Frontpage запустит 

программу, предназначенную для просмотра файлов фор-

мата GIF, и откроет в ней выбранный файл.  

4.  Полюбуйтесь на значок, выбранный мастером, и закройте 

графическую программу.  



116 

 
Рис. 5.5. Режим просмотра папок  

 

5. Для возврата в предыдущую папку щелкните в панели 

списка файлов правой кнопкой мыши и выберите в кон-

текстном меню команду Вверх на один уровень (Up One 

Level).  

6. Выберите команду Файл > Создать > Папка (File > New > 

Folder). В списке папок появится значок новой папки с 

именем Новая папка. Щелкните на нем правой кнопкой 

мыши и в контекстном меню выберите команду Переиме-

новать (Rename).  

7.  Введите текст Дополнения. Это будет имя новой папки.  

8. В списке папок щелкните на значке Дополнения, чтобы от-

крыть новую папку.  
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9.  Щелкните в пустом списке файлов правой кнопкой мыши 

и выберите команду Создать страницу (New Page).  

10. В качестве имени новой web-страницы введите Справоч-

ник. htm. Мы не будем сейчас наполнять новую страницу 

содержанием, но, чтобы не забыть о необходимости сделать 

это в дальнейшем, запишем соответствующий пункт в спи-

сок задач.  

11. Щелкните на значке Справочник.htm. Выполните команду 

Файл > Создать > Задача.  

12. В поле Имя задачи (Task Name) открывшегося окна созда-

ния задачи (рис. 5.6) введите текст Создать страницу и 

ссылки.  

 
Рис. 5.6. Добавление задачи  

 

13. Нажмите клавишу Tab и введите имя исполнителя задачи.  

14. В поле описания введите текст Создать страницу справоч-

ника по продуктам компании с таблицей, добавить ссылки с 

домашней страницы и на страницы описания продуктов.  

15.  Щелкните на кнопке ОК.  

16.  Выберите команду Вид > Задачи (View > Tasks). В списке 

операций вы увидите только что добавленную задачу со 

статусом Не запущена (Not Started).  
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5.3 Упражнение 3. Переходы  

 Мастер web-узла конструирует ссылки между страницами 

по определенному алгоритму. Вам может не понравиться созданная 

им структура связей. С помощью режима просмотра Переходы 

можно увидеть общую схему узла, добавить или разорвать опреде-

ленные ссылки, скорректировать правила размещения ссылок в па-

нелях навигации web-страниц.  

1.   Щелкните на кнопке Переходы (Navigation) панели режи-

мов.  

2. Чтобы вместить в область экрана всю схему узла, выберите 

в раскрывающемся списке Масштаб (Zoom) панели ин-

струментов Переходы (Navigation) пункт По размеру дан-

ных (Size To Fit).  

 
Рис. 5.7. Режим навигации  
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 Теперь структура навигации будет выглядеть так, как пока-

зано на рис. 5.7. Каждая страница узла обозначается прямоуголь-

ником. Линии, соединяющие эти прямоугольники, символизируют 

взаимную подчиненность страниц. Например, страница Услуги 

(Services), с одной стороны, подчинена домашней странице Домой 

(Ноmе). Это означает, что Frontpage автоматически разместит в 

нижней части страницы Услуги ссылку на домашнюю страницу. С 

другой стороны, страница Услуги обеспечивает доступ к трем под-

чиненным страницам Услуги 1, Услуги 2 и Услуги 3. Frontpage по-

местит ссылки на них в самом начале страницы Услуги. Давайте 

изучим такие ссылки.  

3.  Чтобы перейти из навигатора к просмотру страницы Услу-

ги, дважды щелкните на ее прямоугольнике. При этом ав-

томатически включается режим Страница.  

4.  С помощью вертикальной полосы прокрутите содержимое 

страницы Услуги вниз, чтобы увидеть ссылки, расположен-

ные в ее нижней части, как показано на рис. 5.8. Обратите 

внимание, что Frontpage дополнительно поместил ссылки 

на подчиненные страницы в левом поле, а ссылка на роди-

тельскую страницу Домой присутствует только внизу.  

Примечание  
Опробуйте действие имеющихся гиперссылок. Чтобы активизиро-

вать ссылку в режиме Страница, щелкните на ней, удерживая 

нажатой клавишу Ctrl. Перемещаясь по страницам с помощью ссы-

лок, сравните структуру страниц со схемой навигатора узла.  

5. С помощью команды Вид > Способ перехода (View > 

Navigation) вернитесь в режим переходов.  

6. В левой части экрана расположена панель папок web-узла. 

Разверните в ней папку Дополнения, щелкнув на соответ-

ствующем значке «плюс». В этой папке расположена web-

страница, созданная в предыдущем упражнении. Пока что 

она не включена в состав узла. Если предположить, что эта 

страница будет содержать сводную таблицу характеристик 

товаров фирмы, то ее следует подчинить странице Продук-

ты (Products).  

7.  Поместите указатель на значок Справочник.htm панели па-

пок.  
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Рис. 5.8. Режим просмотра страницы  

 

5. Нажмите кнопку мыши и перетащите указатель в область 

схемы узла, чтобы появился прямоугольник новой страни-

цы.  

6. Разместите прямоугольник выше прямоугольника Про-

дукт1, чтобы линия связи соединяла новую страницу со 

страницей Продукты. Затем отпустите кнопку мыши. 

Frontpage добавит в структуру узла страницу Дополнения/ 

Cnpaвочник.htm и поместит ссылку на нее в левое поле 

ссылок страницы Продукты. В режиме навигатора можно 
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не только добавлять новые, но и удалять ненужные страни-

цы.  

7. Щелкните на странице Услуги 3 правой кнопкой мыши и 

выберите в контекстном меню команду Удалить (Delete).  

8.  В открывшемся окне диалога выберите положение пере-

ключателя Удалить страницу с Web-узла (Delete This Page 

From The Web), азатем щелкните на кнопке ОК. Файл стра-

ницы будет удален с диска, а его значок — из схемы узла и 

всех папок.  

 
Рис. 5.9. Переименованные страницы  

 

 Ориентацию схемы можно изменить, щелкнув на кнопке 

Портретная/альбомная (Portrait/Landscape) панели инструментов 

Переход.  
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Примечание  
Выбор положения переключателя Удалить страницу из структуры 

переходов (Remove Page From The Navigation Structure) удаляет 

ссылки на данную страницу из панелей других страниц, но сохра-

няет файл страницы на жестком диске.  

12. Заголовок Дополнения/Справочник.htm не слишком хорош 

для web-страницы. Чтобы изменить его, щелкните на пря-

моугольнике этой страницы правой кнопкой мыши и выбе-

рите команду Переименовать, затем введите текст Спра-

вочник товаров. Этот же текст теперь будет использоваться 

в качестве заголовка на самой web-странице.  

 

 
Рис. 5.10. Новая структура узла  
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13.  Нажмите клавишу Tab. Frontpage автоматически перейдет 

в режим редактирования названия следующей страницы. 

Введите слово Трубы.  

14.  Переименуйте другие страницы в соответствии с рис. 5.9, 

перемещаясь по ним с помощью клавиш Tab и Shift+Tab. 

Как видно из схемы узла, страницы Отзывы и Содержание 

не связаны с другими страницами. Чтобы предоставить 

пользователю доступ к этим двум страницам, выполните 

следующие действия.  

15. Перетащите прямоугольник страницы Содержание вправо 

вверх, подчинив его домашней странице Геркулес и разме-

стив выше страницы Новости.  

Примечание  
Порядок расположения прямоугольников в схеме узла небезразли-

чен, он определяет порядок размещения ссылок в панелях навига-

ции web-страниц.  

16. Перетащите страницу Отзывы вправо, переместив ее в под-

чинение группе Услуги, как показано на рис. 5.10.  

5.4 Упражнение 4. Гиперссылки  

 Режим просмотра гиперссылок позволяет просматривать 

дерево гиперссылок и проверять работоспособность внутренних и 

внешних ссылок узла.  

1. Чтобы вывести дерево гиперссылок, щелкните в панели ре-

жимов на значке Гиперссылки (Hyperlinks). На экран будет 

выведен список папок и дерево гиперссылок. Обратите 

внимание в списке папок на миниатюру файла index.htm в 

виде домика. Это файл домашней страницы.  

2. В панели списка папок щелкните на файле products, htm.  

Frontpage поместит значок выбранной страницы в середину окна и 

линиями покажет все ссылки, имеющиеся на этой странице (рис. 

5.11). Давайте смоделируем некорректную гиперссылку, переиме-

новав один из файлов web-узла.  

3.  Щелкните на значке prod03.htm и выберите команду Пере-

именовать.  

4.  Введите текст pi-od04. htm и нажмите клавишу Enter.  
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Рис. 5.11. Просмотр гиперссылок  

 

5.  Откроется окно диалога, предлагающее обновить Гиперс-

сылки, указывающие на переименованную страницу. 

Щелкните в нем на кнопке Нет (No).  

6.  Щелчком на значке products.htm вернитесь к прежней схе-

ме. Выберите команду Сервис > Пересчитать гиперссылки 

(Tools > Recalculate Hyperlinks).  

7. В открывшемся окне диалога щелкните на кнопке Да. 

Frontpage просмотрит ссылки web-узла и проверит их со-

стояние (при работе с большими узлами этот процесс мо-

жет занять продолжительное время). Программа обнаружит 

на странице products, htm ссылку на несуществующий файл 

prod03.htm. Это отразится на схеме (рис. 5.12).  
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Рис. 5.12. Разорванная гиперссылка  

 

Примечание  
Обычно следует выбирать ответ Да (Yes). Этот вариант дает указа-

ние Frontpage скорректировать ссылки так, чтобы смена имени 

файла не внесла путаницы в структуру узла и не нарушила его ра-

ботоспособность. По указанной причине никогда не переименовы-

вайте файлы узла в Проводнике или с помощью других инструмен-

тов Windows. Пользуйтесь для этих целей списком файлов в окне 

Frontpage. Операционная система в отличие от Frontpage не спо-

собна модифицировать другие web-страницы, приводя их ссылки в 

соответствие новому имени файла.  

 Обратите внимание, что миниатюры файлов, связанных со 

страницей products, htm снабжены символами «плюс». Они разво-

рачивают соответствующую ветвь паутины ссылок.  
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Рис. 5.13. Раскрытие ветвей ссылок  

 

8. Щелкните на значке «плюс» миниатюры prod0l.htm.  

9. Затем щелкните на значке «плюс» появившейся миниатюры 

index.htm. В окне появится новый фрагмент web-узла, пока-

занный на рис. 5.13.  

 Такое раскрытие ветвей в схеме гиперссылок позволяет 

наглядно моделировать логику работы узла, не открывая сами web-

страницы, загрузка которых часто занимает много времени и опе-

ративной памяти.  
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